unitron TrueFit software

Instruction guide

Version 5.1

Version 5.1 supports the following product families;

Era Platform: Quantum, Quantum?, Moxi, Moxi?, Max, Shine Rev
North platform: Moxi, Stride

Tempus platform: Moxi, Stride, Insera, Max, Shine Rev+
Discover platform: Moxi, Stride

Discover Next platform: Moxi, Stride, Insera

Blu platform: Moxi, Stride

For the following features in Unitron TrueFit, specific fitting guides are available:

Automatic REM
Remote Adjust
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NOAH and standalone versions

Unitron TruefFit fitting software is available both as a NOAH module and as standalone
software. The only difference with these versions is the client information storage. For

the NOAH version, the fitting software relies on NOAH’s database to save client specific
information including audiogram. The standalone version does not use NOAH and contains
its own client database.

Programming information

Prior to detecting the hearing instrument(s), choose your desired programming interface.
Note: During programming hearing instrument controls, automatic program, accessories,
easy-t, easy-DAl, audio streaming, Bluetooth® connectivity, and automatic microphone
options are deactivated.

|CubeII

If using iCube Il for the first time, you will need to configure the fitting
device. From the top menu select Options » iCube Configuration and follow
the on-screen instructions.

* IfusingiCube Il, insert batteries into the hearing instruments and close the
battery door. Place hearing instruments on your client’s ears and place the
iCube Il around your client’s neck or place the hearing instruments inside
the iCube Il neck loop.

NOAthk/HIPRO

If using NOAHILink or HI-PRO with BTE or RIC hearing instruments, open the battery door
and insert the programming cable into the programming port. Connect the other end of
the cable to the NOAHIink or HI-PRO.

*  Ifusing NOAHIlink or HI-PRO with ITE hearing instruments, remove the battery door and
insert the programming cable. Connect the other end of the cable to the NOAHIink or
HI-PRO.

Note: BTE and RIC hearing instruments are initially fit to a 40 dB HL flat hearing loss
configured for the left ear upon shipping. ITE hearing instruments are fit to the client’s
audiogram if supplied; otherwise, the devices are using a 40 dB HL flat hearing loss.

Note: For Quantum or Quantum? micro CIC products or Quantum? 10A, Stride 10A,
Insera 10A or Shine Rev+ 10A custom products, ensure you are using the white
programming cable to avoid damaging the hearing instrument.

Note: Shine Rev hearing instruments are non-wireless and can be programmed with
NOAHIink or HI-PRO.

The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such
marks by Unitron is under license. Other trademarks and trade names are those of their respective owners.
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Noahlink Wireless

e To switch the units on, if the units have no battery door, press and hold the lower part
of the button on each of the hearing instruments for 3 seconds until the indicator light
changes temporarily to solid green. For units with a battery door, insert batteries into
the hearing instruments and close the battery doors. This will also place the units in
pairing more, which lasts for 3 minutes.

e Ifconnecting to hearing instruments that are not saved in the current session, the
hearing instruments must be in pairing mode.

* If connecting to hearing instruments that are already saved in the current session, the
hearing instruments do not have to be in pairing mode.

Note: All bluetooth instruments are wireless and can only be programmed using
Noahlink Wireless.

Tool bar icons
There are tool bar icons available at the top right hand corner of each screen. a E ﬁ '

Printicon: opens a window that shows the documents available such as
the Fitting Reports and the Getting Started Guides (hearing instruments and accessories,
if applicable). The client’s language for the Getting Started Guides can be selected. The
selected documents can be previewed, printed or saved from this window.

Save icon: saves the current fitting information. Choose from Save to hearing instrument,
Save to database, Save to accessories (if accessory added to fitting).

Undo/Redo: removes or repeats an action that was made in the fitting software. Hover over
the icon to see which action will be affected by clicking. Undo/Redo is available within some
tasks but the list of items to be undone will not carry over across tasks.

Updates available: this icon appears if there are software updates available. Click on this
icon to open the Software Updates tab of the Welcome screen.

Quick View Pane

The Quick View Pane is a multi-tab panel, located in the upper right of the Unitron TrueFit
screen, that provides useful information on the current status of the
hearing instrument fitting. Each tab can be expanded by clicking on D Moxi Jump R 9 | D Moxi Jump R 9

the plus sign to view additional details relating to that section. Located| 0 #exi jump R 5 M RIC | D Maoxi Jump & 9 M R
above the Quick View Pane are additional fitting tools. .

R« Detect 7L

aaaaa

Each tab serves a different purpose:

E Client tab

Provides the client’s name, number, last audiogram date, hearing instrument type
and accessories. Clicking on the plus sign provides access to more information on the
hearing instruments, date of birth, and an area for note entry.
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E Connection tab

Lists current hearing instrument(s) along with the current connection status for each
ear. An X icon next to the associated side (R or L) indicates the device is not connected,
while a checkmark indicates the device is connected. If the connection is lost at any
point, click the Detect bar on the Connection tab to reconnect. Click the plus sign to
expand the Connection tab where you can see at a glance information related to the
fitting device and the hearing instruments.

Note: HI-PRO refers to the original HI-PRO, USB HI-PRO and HI-PRO 2. The HI-PRO that is
actually used is configured using the HI-PRO configuration tool.

u Alerts tab

Provides fitting help and alert messages during the fitting. A yellow-highlighted alerts
tab appears momentarily to inform you of items that could impact your fitting should an
action result in the need to modify the hearing instrument (e.g., recalculation) or affect
another software screen (e.g., program removal changes program toggle on remote
control). Clicking the plus sign provides a list of all help and alert messages that have
occurred during the current fitting. The alert messages are automatically removed after
being addressed during the fitting, after closing a session or via the remove icon on the
alert tab.

E Client View tab

Allows you to display client oriented screens on a second monitor while using

Unitron TrueFit software. The client screens may change depending on the task being
performed by you. For example, screens were created for the feedback test to remind
the client to remain quiet. Using checkboxes, you can select a screensaver, client view,
or none. The screen selected for the second monitor is displayed within the quick view
pane area. Clicking the plus sign provides you with available screen options. There may
be secondary screens for you to choose to display such as on the audiogram screen
there is a diagram of the ear.

Located beside Quick View pane area

myUnitron account

This area allows you to see if you have signed into your myUnitron account in Unitron
TrueFit. Once signed in, you will have access to features like Insights, myUnitron online
services, etc.

If you have not signed in, click the link to see a dialog where you can enter your

credentials, register for a new account, recover your password, and enable Insights and
FLEX:TRACKER™

Once you have signed in, your user name will be shown here. Click on it to see the
following options:

*  Sign out. Your user name will be remembered in Unitron TrueFit

e Link to mylInsights website

e Link to FLEX:TRACKER
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Recalculate
siise Recalculates the fitting based on the curren
aUdlogram: ﬁttlng formUla: hearlng Instrument The following changes affect the current fitting calculation.
|Z aCOUStICS etC Recalculate the fitting to apply them on the hearing instruments.
. ’ : X * Audiogram
CIICk the RecalCUlate bUtton tO See a“ the pendlng D\groreand do not remind me again during this session
changes and the recalculation options. In addition. you may also:
. . . [[] Reset adaptive features
The pre-selected recalculation options vary depending on the T
pendlng ChangeS [] Discard current fitting and start over
Note: The Recalculate button will be highlighted in orange when

a recalculation is recommended during fitting. When you enter
the Fitting section with pending changes, for example, hearing instrument acoustics,
the Recalculate dialog will appear to remind you that a recalculation is recommended
before further fine tuning is performed. You can select to ignore the recalculate dialog
which will prevent it from appearing again during the current active session. However,
the Recalculate button will remain highlighted in orange as a persistent reminder that a
recalculate is recommended.

(] Quiet |#) | Mute / unmute

Indicates the current state of the hearing instrument(s): muted or unmuted. Mute /
unmute can be selected individually for each device or binaurally by clicking the centre
of the button. The centre of the button also lists the currently active environment for the
hearing instrument(s).

2 | ¥ | Fitting Mode

Fitting mode is designed to efficiently provide age-appropriate hearing aid settings
based on the unique fitting needs of children versus adults. When client information is
entered and the age is 18 years or less, Unitron TrueFit will automatically prompt you to
select the appropriate fitting mode option via a pop-up window. The fitting mode can
be changed by clicking on the button and selecting the desired setting from the drop-
down box.

Note: Fitting mode defaults can be edited under Options » Preferences »
Fitting Session » Pediatric Modes.
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Client menu
Client ==
Instruments = |
Fitting % T Lﬁ@ ’))@
Enq Fitting Audiogram RECD REUG
Insights

Information
NOAH version

When running Unitron TrueFit under NOAH, the information screen is primarily for reference
purposes showing details of the Client Summary, Session Summary and Accessories.

Standalone version

When running the Unitron TrueFit standalone version, the Client > Information screen is the

interface with the client database.

To enter a new client in standalone:

1. Click on the New Client button.

2. Enterthe client information in the appropriate fields. The minimum required information
is indicated with an asterisk (*).
Note: The client’s gender will impact the targets generated by NAL-NL2; client’s date of
birth will impact the Automatic Adaptation Manager setting, the recommended fitting
mode, and the default values assumed for acoustic transforms (e.g., RECDs).

3. Click Save. A Client Summary table at the bottom of the screen will be populated with
the client information and the client will be visible in the Clients and Sessions table.

To edit client information in the future, click on the Edit Client button in the summary area, or

click on the Edit icon in the Clients and Sessions table.

To find client information in the database:

1. Type the client name into the search field.

2. Click the Search icon. A list of client records matching the search criteria is displayed in
the table. The list may be sorted by clicking the column headings.

To create a fresh session for the client containing no previous audiometric or fitting

information, click on the Blank Session icon. In the Clients and Sessions table:

*  Double clicking on a client will open the last session for that client or if the client does
not have any sessions it will open a blank session.

e You can delete a specific client by clicking on the client and then clicking the Delete
Client icon.

e Foreach client you can view all of their session information by clicking on the plus sign
to the left of the client number.

* You can open a specific session by clicking on that session and then clicking the Open
Session button oricon.
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* You can delete a specific session by clicking on the session and then clicking the
Delete Session icon.

* You can create a blank session by clicking on the client information and then clicking
Blank Session icon.

Audiogram
NOAH version

When running Unitron TrueFit under Noah, the audiogram screen is primarily for reference. The
transducer used for audiometry and the tinnitus match sections are used as described below.
To enter or change all other audiometric information, use the Noah audiogram module.

Standalone version

When running the Unitron TrueFit standalone version, the audiogram screen provides the
ability to enter the client’s audiometric test results.

Select the transducer used for audiometry from the dropdown menu.

Note: ABR eHL and ABR nHL data is only used with the DSL v5 fitting formula.

To complete the audiogram, enter the data for the appropriate ear by clicking on the graph.
Right clicking the graph provides the option to: Set point, Remove point, Remove all points or
Copy (all curves) or Copy selected curve to the other ear. In addition, right clicking provides the
option of specifying the measurement type for each data point; choose from: Unmasked, No
response, Unmeasurable, Masked, Masked and no response or Masked and unmeasurable.

* To enter air conduction data, click on the AC button.
* To enter bone conduction data, click on the BC button.
*  To enter uncomfortable loudness level data, click on the UCL button.

Note: NAL-NL1 and NAL-NL2 do not use UCL data for target generation.

* To copy the entered curve from one ear to the next, click on the arrow icons above the
graph for the respective ear.

* Todelete all of the curves on the audiogram, click on the Remove (Delete) icon.

e C(lick on Use Audiogram to use the Audiogram for fitting formula targets.

¢ Click on Use In Situ to use the measured In Situ data for fitting formula targets.

Note: In cases where an In Situ measurement was previously conducted, you will see this

information faded in the background behind the standard audiogram data when Use
Audiogram is selected.

e Ifdesired, speech sounds and common sound icons can be displayed on the audiogram for
counselling purposes by selecting the check box for the desired information.

e Measured Tinnitus Match information can be entered at the bottom of the Audiogram screen.

* To enter tinnitus pitch match frequency, type in the value directly or choose a desired
frequency via the dropdown box. The entered frequency must be between 125 Hz and 8000 Hz.

* To enter the corresponding tinnitus loudness level, type in the value directly or choose
a desired dB SL value via the dropdown box. The entered value must be between 0 and
20 dBSL.

Note: Tinnitus match information is only used in the pre-calculation of the tinnitus masker noise.
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RECD

This screen provides the option to enter real-ear- to-coupler difference (RECD) values or
import them if they already exist in NOAH. (See Importing RECD or REUG from NOAH). If
RECD values have not been measured, age-appropriate average values generated by the
selected fitting formula will be used for the quick fit calculation.

To complete the RECD screen, click the Enter RECD button to launch a wizard that will ensure
you enter all of the mandatory data. Right clicking on the graph provides the option to: Set
point, Remove point or Remove all points.

Select the values for Earpiece used for measurement and the Coupler used for reference
measurement from the drop down menus and select the date that the RECD measurement
was taken.

If the BTE Coupler is selected you will additionally be required to make a selection from the
Measurement Equipment drop down.

Once all of the mandatory data selections have been made, the OK button will become
active allowing you to add the RECD measurement data to the fitting.

The entered curve can also be copied to the other ear by clicking on the arrow icons located
between the graphs.

Click on Use Entered RECD to use the RECD data entered into the graph as the basis of
fitting formula targets. Deselect Use entered RECD to use age appropriate average RECD
values as the basis of fitting formula targets.

Note: If a hearing instrument is already selected a grey curve will appear on the RECD graph. This
grey curve represents the average data for the client’s age and earpiece condition.

REUG

This screen provides the option to enter real-ear unaided gain (REUG) values or import them
if they already exist in NOAH. (See Importing RECD or REUG from NOAH). If REUG values
have not been measured, age-appropriate average values generated by the selected fitting
formula will be used for the quick fit calculation.

To complete the REUG screen, enter the data for the appropriate ear by clicking on the
graph. Right clicking on the graph also provides the option to: Set Point, Remove Point,
Remove all points or Copy to the other ear. The entered curve can also be copied to the
other ear by clicking on the arrow icons located between the graphs.

Select the sound field speaker location used during the measurement from the drop-down
menu, choose from: O degrees, 45 degrees or 90 degrees azimuth.

Click on Use Entered to use the REUG data entered into the graph as the basis of fitting
formula targets. Click on Use Average to use age appropriate average REUG values as the
basis of fitting formula targets.

Note: If a hearing instrument is already selected a grey curve will appear on the REUG graph. This
grey curve represents the average data for the client’s age and speaker location.
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Importing RECD or REUG from NOAH

If there is RECD and / or REUG data stored in NOAH for the current client, then on the RECD
and / or REUG screen there will be a button that asks if you would like to import this data.
Importing the data from NOAH will overwrite data that you had manually entered in Unitron
TrueFit. If the imported RECD contains values for all of the mandatory fields, then the RECD
settings will automatically be added to TrueFit. If however, the data imported from NOAH
does not contain values for all of the mandatory fields, the wizard will be shown and the
user will need to manually add the missing content before being allowed to select OK and
add the RECD to TrueFit.

Instruments menu

Client
! o
nstruments -
A~ Ij’
Fitting Q)SD E“ISD Q (
End Fitting
Insights

AL

7 [y

Technology Acoustics Accessories Pre-Fitting In Situ
Change

Selection

The Selection screen provides the option to detect or simulate a hearing instrument.

Detect hearing instrument(s):

1. Choose the desired programming interface from TR Sod B o = .
the drop-down menu. Choose Noahlink Wireless, . ST LT .
iCube II, NOAHlink or HI-PRO. e F_.ﬂ ,1 f sw
Note: HI-PRO refers to the original HI-PRO, USB HI- L Y; BESS . e “ |
PRO and HI-PRO 2. The HI-PRO that is actually used }“ oo e o .
is configured using the HI-PRO configuration tool. ;,,ﬁ

2. Click the Detect button to perform a detection. 0
Note: BTE and RIC fittings using iCube Il may need to =

be assigned to a side (right or left). Select the Play beep button in the Detection dialog
window to confirm the side assigned to each instrument.

Note: If using Noahlink Wireless, put hearing instruments in pairing mode. For units
that have no battery door, press and hold the lower part of the button on each of the
hearing instruments for 3 seconds until the indicator light changes temporarily to solid
green. For units with a battery door, the units can be put in pairing mode by opening
and closing the battery door. Pairing mode lasts for 3 minutes. To identify hearing
instruments, use Play beep button or press the push button (if applicable) on the
hearing instruments to highlight corresponding instrument on screen.

3. Incases where the data in the hearing instrument differs from that stored in the
software:
e Click Use fitting from hearing instrument to use data stored in the hearing

instrument (including any data logging / learning information).

e Click Use fitting from this session to use data stored in the software.
*  Click Create new fitting to setup the hearing instrument using software defaults.
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If fitting a new client, or if the user has chosen to create a new fitting, then the Initial
Configuration workflow (see below) will be displayed. For all other fitting scenarios, following a
Detect the user will be directed to the Insights Overview screen.

Initial Configuration

Since the release of Unitron TrueFit 4.1, the Initial Configuration workflow is optionally displayed
following detection of hearing instruments.

The workflow is displayed when:
*  Anew client is being fitted for the first time with new hearing instruments, or
* Youselect to Create New Fitting at the end of the Detect sequence.

When Unitron TrueFit is reading a fitting from the detected hearing instruments, the workflow will
not be displayed and you will be taken to the Insights Overview screen.

If the workflow is launched, there are five potential screens in the workflow.

Note: the hearing instruments will be muted, and the Back and Next buttons will allow you to
navigate back and forth between the screens:

1. Confirm technology level: The first screen shown if fitting a FLEX:TRIAL unit. This screen
allows you to view the differentiation in features between the current and other available
technology levels. Click Next to maintain the current level. If you want to make a change,
clicking Apply will launch the Change Technology Level wizard.

2. Confirm client information: The first screen shown if fitting a non FLEX:TRIAL device. On this
screen you review the client’s date of birth and audiogram and confirm their experience
with hearing instruments, i.e. First Time or Long Term. If no audiogram is available for either
side, the InSitu buttons will be shown allowing you to run through the InSitu workflow. If you
need to change either the date of birth or the audiogram information select Cancel to make
the changes. Note: This will disconnect the hearing instruments and following a subsequent
Detect, the Initial Configuration workflow will be launched again.

3. Confirm device acoustics: Asks you to confirm the device acoustic settings with the option to
change values if necessary.

4. Confirm initial configuration: On arrival at this screen, the first fit has been calculated and
the hearing instruments will automatically be unmuted (the option exists to manually mute
again if required). Additionally, you have the option to alter the Fitting Formula or make
adjustments to the Adaptation Manager, with the ability to launch the Feedback Optimization
workflow if necessary.

5. Initial configuration complete: As the final screen in the workflow, this provides quick links
to the most common follow on actions within Unitron TrueFit (i.e. Tuning, Program Manager,
Insights Setup, Accessories or Fitting Summary). Or you can exit the workflow by selecting Close
where you will be returned to the screen from where you initially launched the device Detection.
If fitting Moxi All, Discover, wireless Discover Next or Blu products, the settings to enable
Insights for that client are displayed. Display of this section is conditional upon you already
being logged in to your myUnitron account and having Insights enabled.

Note: If selecting to add the client’s details to mylnsights, it is not mandatory to provide the
email address. The client’s email is only required if you want to be able to send an Overall
Satisfaction email survey at a future date.
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Simulate hearing instrument(s)

1. Click the button for your desired product line in the hearing instrument simulation section on
the left hand side of the screen. If you know what technology level you want, you can also
click directly on the technology level button within the product line button to skip step 2.

2. Click on the desired technology level. To see more information about the different technology
levels, click on the + sign beside the Technology Level title to view a feature comparison.

3. Select the desired style for that product line and technology level. To see more information
about each style, click on the + sign beside the Styles title. When selecting a product style for
simulation, clicking the centre of the button performs a binaural selection, while clicking the
R or L buttons performs a monaural selection. At the top of the screen, under Current Product
in this Session, you can see a summary of the products you have selected. For most product
styles, you will also have a couple of acoustic options that you can select here or you can go
to the full list under Instruments » Acoustics. Any changes made here will also be updated
on the Instruments » Acoustics screen. Furthermore, if you wish to detect a product while on
the simulation screen, select the desired programming interface from the drop-down menu
in the upper left column of the screen, and then click Detect. The process will follow the steps
outlined above in the Detect hearing instruments section of this guide.

Technology Change

Select the Technology Change screen to access FLEX™ functionality. With FLEX:TRIAL devices,
you can select from one of the displayed technology levels. Clicking on one of the technology
level buttons will launch the Change Technology Level wizard. Follow the on-screen instructions
to change the technology level of the connected FLEX:TRIAL hearing instruments. The wizard will
provide the following options: Transfer fitting, Create new fitting.

If you select Transfer fitting, then the program structure, frequency response, acoustics, Automatic
Adaptation Manager status and accessories in the current client session will be transferred to the
hearing instruments after the technology level change is complete.

If you select Create new fitting, then after the technology level change is completed, the hearing
instruments will be set to the recommended defaults. Select your desired option and continue
through the steps in the wizard.

Following completion of the technology change, proceed to End Fitting » Beeps » Trial Duration to
configure the duration of the client’s trial period with the hearing instruments. When the trial period
expires, the ‘End of trial. beeps will play. See the End Fitting menu section for more details.

Note: The transfer fitting process will reset all adaptive features to the recommended defaults for
the new technology level.

Note: Create new fitting will reset all hearing instrument settings including the acoustic options. You
should confirm that the hearing instrument parameters are set as desired following this process.

Note: The data logging in the hearing instrument will be lost during this process.

Note: The current technology level contained within the hearing instrument is indicated by the
shaded blue button and also is displayed in the Quick View Pane connection tab.

Note: FLEX:TRIAL is available in all RIC (Moxi) and BTE (Stride & Max) form factors, with the
exception of Moxi Now.
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Acoustics

Select the Acoustics screen to configure items such as: coupling, venting, earhook, tubing,
earpiece, receiver unit, and Peak Resonance.

BTE and RIC instruments

e Ifyou have ordered your earmold, cShell, or sleeve molds with IntelliVent, enter the
code and the software will automatically use the optimal venting.

*  For BTEs select Regular Tube, Slim Tube or Power Slim Tube (Max only).

* For BTEs with an earhook, select Vent size, Earhook type and Tubing type.
(Note: with Discover and Discover Next, Earhook and Tubing settings will default to
values of ‘Filtered” and ‘Standard’ respectively. No drop downs will be displayed.)

* For BTEs with Slim Tube, select your Ear Piece, Vent and Tubing Length (optional).
* For MaxBTEs with Power Slim Tube, select your Ear Piece, Vent and Tubing Length.

Note: The tubing length parameter is for record keeping with slim tubes and has no impact
on the output of the system. In contrast, tubing length will impact Max products with power
slim tubes and should be set appropriately as this parameter will influence the quick fit.

*  ForRICs (Moxi on Era, North or Tempus platforms), select your Receiver, Ear Piece,
Wire Length (optional) and Dome Size (optional). Note: The wire length and dome size
parameters are for record keeping only and have no impact on the output of the system.

*  ForRICs (Moxi on the Discover, Discover Next or Blu platforms) using SDS 4.0, Unitron
TrueFit automatically detects the receiver during the detection process. Press the Check
button to manually check that the fitted receiver is in fact the one you have selected
in Unitron TrueFit software. A receiver is recommended based on your client’s hearing
loss. The recommended receiver will be indicated by a target symbol.

Note: Click on the Recalculate button after configuring the acoustic parameters to ensure
the product fitting considers these aspects.

Custom instruments

For custom instruments, you can configure the vent. If you have ordered the custom
products with IntelliVent, the software will automatically read the code and use the optimal
venting.

Note: With simulated fittings, you can also select the shell and receiver type using the
provided drop-down menus on the Acoustics screen (if applicable). In contrast, these
parameters are read from the detected hearing instrument and cannot be changed through
the software.

Accessories

The accessory screen will show those accessories which are compatible with the hearing aid(s)
selected or detected. By clicking on the accessory, you can activate or simulate an accessory for
configuration purposes.

If an accessory button has a check mark in the corner, then at least one of these accessories has
been added to the fitting. You will also see the serial number of an activated accessory or the
word Simulated if the accessory has just been simulated.
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Remote Control / Remote Control 2

To pair a remote control:

1. Click the Remote Control button.

2. Click the Activate button.

3. A Detect new accessories pairing wizard appears. Connect a USB cable to the remote
control and your computer, and follow the on-screen instructions.

4. After pairing, the serial number of the paired remote control is automatically shown
in the serial number box. Various check boxes and a drop-down menu appear to
configure the remote control.

To simulate a remote control:

1. Click the Remote Control button.

2. Click the Simulate button.

3. The serial number box will say Simulated Remote Control and a graphic with various
configuration options appears.

Note: You can select the Delete icon to remove any paired / simulated accessory from

the fitting. You can add up to 4 remote controls to the hearing instrument fitting. Any

simulated remote control can be added later to the fitting by clicking the Activate button

beside the row assigned to the simulated accessory. To modify the configuration of a

paired remote control, click on the serial number of the device you would like to modify.

With Discover Next and Blu devices, you can add a Remote Control device but there are no
configurable elements, merely the option to “Include in fitting” and “Remove from fitting”
allowing you to track if your client has one of those devices.

PartnerMic

With Discover Next and Blu devices, you can add a PartnerMic but there are no
configurable elements, merely the option to “Include in fitting” and “Remove from fitting”
allowing you to track if your client has one of those devices. If a PartnerMic is included,
an explanatory section of text will be added to the Getting Started Guide confirming the
selected activation behaviour.

uDirect 2 / uDirect 3

To pair uDirect 2 / 3:

1. Click the uDirect 2 / 3 button.
2. Click the Activate button.

3. Detect new accessories pairing wizard appears. Connect a USB cable to the
uDirect 2 / 3 and your computer, and follow the on-screen instructions.

4. After pairing, the serial number of the paired uDirect 2 / 3 is automatically shown
in the serial number box. Various check boxes and a drop-down menu appear to
configure uDirect 2 / 3. These controls include:

Notification Options:

There are three levels of notification.

1. Warnings only — low uDirect 2 / 3 battery; Bluetooth pairing process.
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2. Standard — Warnings only notifications + uDirect 2 / 3 on/off; starting/ending
charging during streaming; input channel confirmation; FM announcements; plus
for uDirect 3 transfer call and hold call.

3. Detailed — Standard notifications + starting/ending charging without active
streaming; external microphone connection; Bluetooth device connect/disconnect;
transfer call; hold call.

In addition, you can select whether the notifications above are provided via ‘Beeps’
or ‘Spoken’ words. Should you select ‘Spoken’, you have the option of selecting the
language used for the notifications, selected via the provided drop-down menu.

Enable Caller ID

Select to enable / disable the use of spoken caller ID notification for incoming call on
phones supporting this feature.

Phone Streaming Functions
Access button options:

1. Redial — select to enable redialing of the last number called on phones supporting
this feature.

2. Transfer call back to phone — select to enable the client to transfer a streamed
phone call back to their paired phone.

Connect button options:

1. Voice dial — select to enable voice dialing for phones supporting this feature.

2. Hold — select to enable access to the functionality to put a phone call on hold.

3. Hear own voice during call — select to allow user to hear their own voice during a
call which is more natural sounding, especially for closed fittings. Select the desired
attenuation for the client’s own voice.

Remote Control Functions

Check this to allow the uDirect 2 / 3 to function as a remote control when the hearing
instrument is not in streaming mode. Configure the ‘Plus/Minus’ buttons. Enabling
Remote Control Functions also makes it possible for the hearing instrument state
information to be passed to the uControl app providing context for Ratings.

Simulate

To simulate uDirect 2 / 3:

1. Click the uDirect 2 / 3 button.
2. Click the Simulate button.

3. The serial number box will say Simulated uDirect 2 / 3 and a graphic with various
configuration options appears.

Note: You can select the Delete icon to remove any paired / simulated accessory from
the fitting. You can add up to 4 uDirect 2 / 3 to the hearing instrument fitting. Any
simulated uDirect 2 / 3 can be added later to the fitting by clicking the Activate button
beside the row assigned to the simulated accessory.

Note: To perform remote control functions, the uDirect 2 / 3 must be paired to the
hearing instrument. You can use the uDirect 2 / 3 without pairing it with the hearing
instruments, but for streaming only.
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Note: Allow uDirect 2 / 3 streaming to other wireless Unitron hearing instruments:
Uncheck to prevent uDirect 2 / 3 from working with Unitron devices it has not been
paired with.

Note: To modify the configuration of a paired uDirect 2 / 3, click on the serial number of
the device you would like to modify.

Note: The input volume correction is not required with this accessory given the user
can configure the volume level of streamed signals via the +/- buttons on the front
of uDirect 2 / 3 and the accessory will maintain the user’s adjustments for future
streamed signals.

uStream

To pair uStream:

1. Click the uStream button.
2. Click the Activate button.

3. Detect new accessories pairing wizard appears. Connect a USB cable to the
uStream and your computer, and follow the on-screen instructions.

4. After pairing, the serial number of the paired uStream is automatically shown in
the serial number box. Various check boxes and a drop-down menu appear to
configure uStream.

These controls include:

Notification Options
There are three levels of notification
1. Warnings only — low uStream battery; Bluetooth pairing process

2. Standard — Warnings only notifications + uStream on/off; starting/ending charging
during streaming; input channel confirmation; transfer call; hold call

3. Detailed — Standard notifications + starting/ending charging without active
streaming; external microphone connection; Bluetooth device connect/disconnect

In addition, you can select whether the notifications above are provided via ‘Beeps’
or ‘Spoken’ words. Should you select ‘Spoken’, you have the option of selecting the
language used for the notifications via the provided drop-down menu.

Enable caller ID — select to enable/disbale the use of spoken caller ID notification for
incoming call on phones supporting this feature.

Phone Streaming Functions

Access button options:

Redial — select to enable redialing of the last number called on phones supporting this
feature.

Hear own voice during call — select to allow user to hear their own voice during a
call which is more natural sounding, especially for closed fittings. Select the desired
attenuation for the client’s own voice.

Remote Control Functions

Check this to allow the uStream to function as a remote control when the hearing
instrument is not in streaming mode.
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Note: Allow uStream to stream to other wireless Unitron hearing instruments: Uncheck
to prevent uStream from working with Unitron devices it has not been paired with.
Note: To perform remote control functions, the uStream must be paired to the hearing
instrument. For streaming only you are able to use the uStream without pairing it to the
hearing instruments.

Note: You can select the Delete icon to remove any paired accessory from the fitting.
You can add up to 4 uStreams to the hearing instrument fitting.

Note: To modify the configuration of a paired uStream, click on the serial number of the
device you would like to modify.

Note: The input volume correction is not required with this accessory given the user
can configure the volume level of streamed signals via the +/— buttons on the front of
uStream and the accessory will maintain the user’s adjustments for future streamed
signals.

Simulate

To simulate uStream:

1. Click the uStream button.

2. Click the Simulate button.

3. The serial number box will say Simulated uStream and a graphic with various
configuration options appears.

Note: You can select the Delete icon to remove any simulated accessory from the fitting.
You can add up to 4 uStreams to the hearing instrument fitting. Any simulated uStream

can be added later to the fitting by clicking the Activate button beside the row assigned
to the simulated accessory.

Note: uStream does not need to be paired to work with Stride & Moxi hearing
instruments.

uControl app

Note: This app has been discontinued for new fittings.

The uControl app button is disabled until you include a uDirect 3 or uStream in the

fitting. The uControl app does not need to be included in a fitting in order to use the

app, however there are three benefits to including the uControl app in a fitting:

1. Instructions on how to access the uControl app can be viewed and / or emailed to
the client.

2. The uControl Getting Started Guide information can be printed and / or emailed to
the client.

3. The Ratings feature can be activated on the app (details below).

Click on Include uControlin fitting to add the uControl app to the fitting.

Remote Plus app
The Remote Plus app is only available for Bluetooth enabled hearing instruments. The
app does not need to be included in the fitting in order to use it.

To install the app and activate Ratings, click on the Go to Insights Setup screen button
(more details in Insights Setup screen).
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Ratings

You must first activate Insights to enable ratings for your client. To do this, you need to:

*  Belogged in to your myUnitron account from within Unitron TrueFit software

*  Enable Insights (a one time only step which will allow you to activate Ratings for
individual clients)

For each client:

*  Following detection, the hearing instruments will automatically be enabled for
Insights activation by the client

*  You have the option to add the client details so you can view them in the
mylnsights portal

The client must then select to Activate Insights from within the Remote Plus app.

If the client encounters an error or if they choose not to activate Insights when initially

setting up the Remote Plus app, they can manually activate Insights at a later date using

a manual activation code. The code is listed in the Getting Started Guide and is also
displayed in the first Info popup dialog on the Insights Setup screen.

Note: The Ratings feature requires an internet connection.

Pre-Fitting

Super/Ultra Power pre-sets (if applicable)
Select your desired pre-set as a starting point for your super/ultra power hearing
instruments fitting.

e Classic: A classic approach to sound processing - for those who prefer things the
‘old way’ with little to no signal processing and no directionality.

e Conventional: A conventional approach to sound processing - for those who prefer
a more traditional approach to amplification, including moderate signal processing
and some directionality.

e Current: A current and modern approach to sound processing - for those who prefer
the latest technology, including advanced signal processing and directionality.

Fitting Formula

Select your desired fitting formula from the provided drop-down menu: DSL v5 Adult,
DSL v5 Pediatric, NAL-NL1, NAL-NL2, and NAL-NL2 Tonal Language.

Processing Strategy

With DSLv5 adult or DSLv5 pediatric, select your desired processing strategy from the
drop-down menu: WDRC or Linear.

Note: Selecting NAL-NL2 or NAL-NL1 provides a WDRC processing option only.

Tinnitus Masker Strategy

Select your desired tinnitus masker signal strategy from the drop-down menu:
Audiogram-based, White Noise, or Pink Noise.

Note: The Tinnitus Masker Strategy task box will only be visible with products
supporting this feature.
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Note: The tinnitus masker strategy impacts the calculation for the frequency shape of
the tinnitus masker noise. The tinnitus masker noise can be viewed and fine tuned in the
Fitting > Tuning > Tinnitus Masker task box.

Frequency Compression Strategy
Specify if Frequency Compression 2 calculates each side independently.

In Situ

Use the In Situ screen to assess hearing sensitivity and uncomfortable loudness levels via
signals generated by the hearing instruments. The In Situ measurement results can be used
to define the fitting formula targets.

1. Click on the Start In Situ button for the device / ear you would like to assess.
2. AnIn Situ wizard will appear. Preparation information is provided to assist with the test.

3. Select the coupling option to be used for the In Situ test. The options available will
depend on the form factor being fitted and can include:

a. Vented (current vent value). Note: Ensure the product venting is configured correctly
in the acoustics screen as it will impact the signal level generated by the device.

b. Temporarily occluded earpiece.

4. After the coupling option is selected, click Continue to get to the In Situ measurement
step.

5. Select the desired measurement type (AC: air conduction or UCL: uncomfortable
loudness level) via the appropriate button.

6. Select the desired frequency /presentation level by clicking on the graph.

7. Present the tone by using the space bar or by clicking the Present Tone button.

8. To present tones automatically when you click on the graph, select the Enable Autoplay
option.

9. Ifyou desire to present tones at a loudness level beyond the safety limit of 100 dB HL,
select the Enable HL » 100 dB HL option.

10. To speak with the client during the test, the hearing instrument microphones must be
enabled by clicking on the Talk to Client button. The volume level of the device can be
adjusted as required using the up/down volume arrow keys.

If you would like to use the In Situ data as the basis for the hearing instrument quick
fit, check the Use In Situ data to recalculate hearing instrument settings check box.
Following completion of the test, the In Situ data will be displayed on the graph, along
with any previous standard audiometric data if it is available.

Note: If a previously entered audiogram is available in the session, it will be shown faded
into the background for reference purposes on the In Situ and Audiogram screens.

Click on Use Audiogram to use the entered standard audiometric data for fitting formula
targets.

Click on Use In Situ to use the measured In Situ data for fitting formula targets.
Note: The In Situ data can be deleted using the Remove (Delete) icon above the graph.

If desired, speech sounds and common sound icons can be displayed on the audiogram for
counseling purposes by selecting the check box for the desired information.
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Tuning

Select the Tuning screen to adjust Adaptation Manager, Occlusion Manager, Bass Enhancer
(Max only), Soft/Mod/Loud Controls, MPO/Gain/CR Controls, App Equalizer, Frequency
Compression (select products), Frequency Compression 2, Fitting Advice, and Tinnitus
Masker (select products). The settings for each program automatically default to suggested
values. Prior to adjusting any of the parameters listed above, select the program you would
like to tune from the program selector list on the left side of the screen. The active program
is highlighted and its name is listed above the graphs and in between the mute buttons.

Note: On moving to the Tuning screen, All Programs is always selected by default. This
ensures that the relative differences across all programs are maintained when making
changes and helps to maintain seamless transitions in the Automatic Program / Integra OS
(Blu platform) or SoundNav (Discover Next platform and earlier).

To fine tune the hearing instrument:

Select the desired program from the program selector list on the left side of the screen.

e Toselect all programs for modification, click the All Programs button at the top of the
program selector list.

e Toselect all automatic programs:
*  Blu platform - click Integra OS

*  Discover Next (and earlier) platforms - click the Automatic / SoundNav program
header above the individual environments.

e Toselect all Media programs:
*  ForBlu platform - select Media
*  For Discover and Discover Next platforms - select MediaNav

e Toselect all manual programs, click the Manual program header above the individual
manual programs.

e Toselect all wireless programs, click the Wireless program header above the wireless
programs.

e Toselect all optional app programs, click the Optional App program header above the
optional app programs.

e Toselect an individual program or environment, click the program name or environment
in the program selector list.

Note: To simplify the view, you can click the plus / minus sign beside the program header to
collapse or expand the program list for that category.
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Adaptation Manager (for Tempus and older products)

1. Click on the Adaptation Manager task item at the bottom of the screen.

2. Selectthe Automatic check box to activate the Automatic Adaptation Manager (AAM).
With Max products, select the Automatic / Power check box to activate the Automatic
Adaptation Manager or the Power Adaptation Manager (PAM). The software will use
a proprietary calculation that considers the client’s hearing loss, age, and hearing
instrument experience level (previously selected via the Client / Experience Level screen,
which has been removed from v4.0 onwards) to determine the starting adaptation
manager setting and the adaptation rate for the fitting.

3. Ifdesired, change the speed of adaptation for the current fitting using the provided
Adaptation Speed dropdown box. Choose from the following adaptation rates (the
number of weeks / months changes depending on the difference between the
Current Value and End Value):

* 5% perweek (~ 6 weeks)

* 5% per 2 weeks (~ 3 months)

* 5% per 3 weeks (~ 5 months)

* 5% per 1 month (~ 6 months)

* 5% per 2 months (~ 12 months)
* 5% per 3 months (~ 18 months)
* 5% per 4 months (~ 24 months)
* 5% per 5 months (~ 30 months)
* 5% per 6 months (~ 36 months)

Note: For Max, when the Current value is above the End Value, the above choices
represent the approximate time for a 5% decrease in the current value of PAM.

Note: For calculation purposes, the adaptation rate assumes one week of use = 70

hours (i.e., 10 hours / day). Thus at the follow-up appointment, the Current position may

differ from what is expected based on calendar days depending on the client’s actual

usage time per week.

4. If desired, you can adjust the Current position (% of target) and the desired End
Value (% of target) for the chosen fitting formula using the provided sliders. If this is
a follow-up fitting and the Automatic Adaptation Manager is enabled, then you will
see a grey bar representing the adaptation progress that has been made so far.

Note: The predicted Time remaining to reach the end value will be updated
automatically depending on the relative position of the Current and End Value sliders.

Note: If desired, the AAM or PAM can be disabled by de-selecting the Automatic check
box. You can then select their desired adaptation manager setting using the Current
slider.

Note: This feature is global and will impact all programs.

Note: For Max products, adaptation manager settings above 100% affect both the ‘%
of target gain’ provided and the MPO setting of the hearing instrument. Adaptation
manager settings below 100% impact only % of target gain.
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Adaptation Manager (Discover and Discover Next products)

There have been some updates to the Adaptation Manager which are applicable to
Discover and Discover Next products only. In essence the controls within Unitron TrueFit
for adjusting the current value are similar to what we had prior to Discover with some key
differences which we will cover here.

1. Click on the Adaptation Manager task item at the bottom of the screen.

2. Select the Automatic check box to activate the Automatic Adaptation Manager (AAM).
Select the Power check box to activate the Power Adaptation Manager (PAM). The
software will use a proprietary calculation that considers the client’s hearing loss,
age, and hearing instrument experience level (selected during the Initial Configuration
workflow) to determine the starting adaptation manager setting and the adaptation
rate for the fitting.

3. Ifdesired, change the speed of adaptation for the current fitting using the provided
Adaptation Speed dropdown box. Choose from the following Adaptation Speed rates
(Slowest, Slow, Moderate, Fast, Fastest) which equates to an approximate number of
weeks that it will take to move to the target value.

Recommended starting value

The Adaptation Manager will recommend a starting value based on the client’s age,
experience level with hearing instruments and their audiogram. If the client is a first-time
user of hearing instruments, the recommended starting value will be less than 100%,
where as if the client is a long-term user of hearing instruments, the recommendation will
be the target fitting value, i.e. 100%.

You can always change the starting value to be either below the recommended value,

or above the recommended value. In addition if you want to set the starting value to be
above the target value, you can select the Power button which alters the scale to allow you
to set a value above target with a maximum setting of 120%.

Recommended starting value markers

There are two persistent black markers to show the recommended starting percentage for
a first time user as well as the target value of 100%. If you choose to alter the value, this
means you will always have a visual indication as to the Unitron recommended values.

Note: If the current value is equal to one of these defaults, you will only see the blue marker.
Automatic acclimatization

‘Automatic’ acclimatization is enabled by default. This provides an automated approach to
acclimatization based on the selection of an Adaptation Speed. The selected Adaptation
Speed is used in a formula which, when applied to the client’s starting value provides an
estimated time to reach full target.

Each pre-defined Adaptation Speed equates to taking x number of days to increase

the current setting by 5% (see table below). A calculation is made taking the client’s
remaining percent value required to reach target, dividing that by 5 (to give the number
of 5% increments) and multiplying that by x (the multiplier to be applied for the selected
Adaptation Speed) to provide the approximate number of days to full acclimatization.
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Note: If Power is selected, the formula works in exactly the same way only it reduces
by 5% increments until it reaches the 100% target.

Speed Days for 5% change
Fastest 2

Fast 4.3
Moderate 5.8

Slow 7.2

Slowest 9

The following examples explain in more detail how it works:

Calculation Formula:

Time to target = ‘Adaptation Speed” multiplied by (‘Percentage to target’ divided by

‘Percentage increments’)

1. Adaptation Speed (AS) = x (where x represents the number of days it will take to
increase the current value by 5%)

2. Percentage to target (PTT) = Target percentage (always 100%) minus Current
percentage

3. Percentage increments (Pl) = 5 (equating to 5%)

Example: Client starting at 60% of target, Percentage to target = 40%

Adaptation Speed  =‘Moderate’, equates to approximately 6 days per 5% change
Time to target =ASx (PTT/PI)
=6x(40/5)
=48 days
= approximately 7 weeks
Adaptation Speed = ‘Fastest’, equates to 2 days per 5% change
Time to target =ASx (PTT/Pl)
=2x(40/5)
=16 days
= approximately 2 weeks

Adaptation Manager (Blu products)

The Adaptation Manager controls for Blu products are similar to Discover and

Discover Next with the following differences:

* The Power check box is no longer available, but you can select a starting point up
to 110% of the target value

* The End value will always default to 100% but this value can be changed if
required

* The starting value will be automatically calculated but this value can be changed
if required

¢ The time for acclimatization will be automatically calculated but can manually
changed to any value from 1 to 100 days

*  Therecommended starting percentage and target (100%) will be shown by two
persistent black markers
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* The End value can not be » 100%
* The End value can not be < the Current value

* Ifyou drag the End value below the Current value, the Automatic will be disabled and
the End value will no longer be shown

* |fthe Current and End values are both the same then both are still shown

Occlusion Manager
1. Click the Occlusion Manager task item at the bottom of the screen.

2. Select your desired occlusion manager setting using the provided options to address
any occlusion related complaints.

Note: This feature impacts all programs by default but there is an option to exclude the
music program.

Bass Enhancer
1. Click the Bass Enhancer task item at the bottom of the screen.

2. Select your desired bass enhancer setting using the provided slider to increase low
frequency gain and MPO (emphasis below ~ 1 kHz).

Note: This option is available with Max products. The feature is global and will impact all
programs.

Soft / Mod / Loud Controls
1. Click the Soft / Mod / Loud Controls task item at the bottom of the screen.

2. Select the program(s) you wish to modify using the program selector list as described
above.

3. Select the frequency resolution using the provided buttons.
Note: The frequency resolution depends on the technology level of the product you
are fitting.

4. Select the frequency region(s) and input level(s) to be modified in the provided table:
* To select an individual frequency region, select the desired value in the table.

* Arange of fitting values can be selected by either choosing a specific input label
(loud, mod, soft), channel grouping label (low, mid, high or specific frequency
columns) or the All table label. The selected frequency region(s) are highlighted in
the table and shaded in the fitting graph.

* To select multiple frequency regions for adjustment, you can also click and drag
across the table. The slider bar along the bottom of the table allows you to view
frequency regions that are outside the visible table area.

* To view all frequency regions for a particular ear, and/or increase the size of the
selectable boxes in the table, click on the View right ear only or View left ear only
text as appropriate. To change the table view back to a binaural view, click on the
text View both ears.

Note: when viewing the values for one ear only, if the view is coupled, then any +/-
changes will be reflected in updates to the graphs for both the left and right ears.
But the specific values displayed in the table will reflect the values for currently
selected ear only. You can toggle between viewing the values for the left ear or right



Unitron TrueFit software instruction guide v5.1

ear, or if you want to view the different values for both ears at the same time, you
can show a binaural view of the values by clicking View both ears.

* Once you have selected your desired region for adjustment, click the dB drop-
down menu to alter the step size of any change. Choose from 1, 2 or 3 dB.

* Click the + or — buttons to apply the desired change.

Note: When a fitting handle has reached its maximum setting, the + button will grey out
(disable). Conversely, if a fitting handle is at its minimum setting, the — button will grey
out (disable).

Note: The table will also display the calculated compression ratios. The compression
ratios are calculated based on the slope of the 1/0 curve between the TK soft and TK loud

inputs.

MPO / Gain / CR Controls

1. Click the MPO / Gain / CR Controls task item at the bottom of the screen.

2. Select the program(s) you wish to modify using the program selector list as
described above.

3. Select the frequency resolution you require for your modification using the provided
tabs.

4. Note: TK soft speech control will be shown if selected within preferences.

5. Select the frequency region(s) and parameter type (MPO, Gain, CR or TK) to be

modified.
* Toselect an individual frequency region, select the desired value in the table.

e Arange of fitting values can be selected by choosing a specific parameter label
(MPO, Gain, CR or TK). The selected frequency region(s) is highlighted in the table
and shaded in the fitting graph.

¢ TKsoft speech can be used to adjust the gain for low level sounds. Impact of
the adjustments is opposite to the other controls: increasing TK soft speech will
decrease gain for low level sounds and vice versa.

* To select multiple frequency regions for adjustment, you can also click and drag
across the table. The slider bar along the bottom of the table allows you to view
frequency regions that are outside the visible table area.

* To view all frequency regions for a particular ear, and/or increase the size of the
selectable boxes in the table, click on the View right ear only or View left ear only
text as appropriate.

Note: when viewing the values for one ear only, if the view is coupled, then any +/-
changes will be reflected in updates to the graphs for both the left and right ears.
But the specific values displayed in the table will reflect the values for currently
selected ear only. You can toggle between viewing the values for the left ear or
right ear, or if you want to view the different values for both ears at the same time,
you can show a binaural view of the values by clicking View both ears.

* Once you have selected your desired region and parameter type for adjustment,

click the dB drop-down menu to alter the step size of any change. Choose from 1,
2 or3dB.

* Click the + or — buttons to apply the desired change.
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Note: When a fitting handle has reached its maximum setting, the + button will grey out
(disable). Conversely, if a fitting handle is at its minimum setting, the — button will grey out
(disable).

Note: The compression ratios are calculated based on the slope of the /O curve between
the TK soft and TK loud inputs.

App Equalizer

Note: This option is only available with Discover Next and Blu wireless products.

On follow up fittings, after you detect Blu or Discover Next devices, Unitron TrueFit will
default to show the Insights Overview screen. This screen will highlight any changes your
client has made to the App Equalizer for the SoundNav / Integra OS program via an alert
in the Quick View Pane, and a yellow " info icon on the quick link to the App Equalizer tool
box.

Open the Tool Box to see the App Equalizer settings that the client has set via their Remote
Plus app for the currently selected program.

Selecting a program will show the settings the client has applied to that program. If the
client has not made any changes via the Remote Plus app, all sliders will be set to zero.
Note: All environments within the SoundNav / Integra OS program share the same settings,
and you can not view settings for the Media, MediaNav, Bluetooth Phone or RogerDirect
programs.

Select Bass, Mid or Treble to see the frequency groupings on the graphs.

Click on a slider and drag it up or down to increase/decrease gain and see the impact
reflected on the graphs. Note: The gain change that the equalizer applies varies

a) depending upon the direction of change (up or down) and b) as a function of the signal
level. The max increase or decrease that will ever be applied is 10 dB.

Any changes made to the sliders will be applied to the hearing instruments in real time.
Click Reset to return all three slider values to zero.

If you change any of the sliders from their initial values, an indicator will mark the value of
the original setting. Note: Changing program selection will delete the initial values for the
previously selected program.

Frequency Compression
Note: This option is available with select products.
1. Click the Frequency Compression task item at the bottom of the screen.
2. Select the program you wish to modify using the program selector list described above.
3. Click the Enable Frequency Compression check box to activate / deactivate this feature.
4. Adjust the Frequency Compression to the desired setting using the More or Less
buttons. Adjusting the frequency compression impacts:
* The frequency at which the compression will begin. Below this specified cut- off, no
frequency compression will be applied.
* The compression ratio or the amount of compression that will be applied in the
frequency domain above the cut-off frequency.
Note: The software will automatically calculate the starting default position of the frequency
compression based on the client’s better ear audiogram and the fitting formula. With
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the DSL v5 pediatric fitting formula, frequency compression default settings are more
aggressive (i.e. lower cut-off frequency, higher compression ratio) to emphasize audibility
of high frequency speech cues for children.

Note: For clients with asymmetrical hearing loss, the frequency compression settings will
be based on the audiometric thresholds from the better ear and applied to both devices in
binaural fittings.

Note: The shaded region on the slider reflects the frequency compression region which is
also displayed on the frequency response graphs.

Frequency Compression 2
Note: This option is available with select products.
1. Click the Frequency Compression 2 task item at the bottom of the screen.

2. Select the program you wish to modify using the program selector list described
above.

3. Click the Enable Frequency Compression 2 check box to activate / deactivate this
feature.

4. Adjust Frequency Compression 2 to the desired setting using the Audibility/Distinction
and Consonant Clarity/Vowel Quality sliders. The sliders have the following impact:

* Audibility/distinction: This slider adjusts both cut-off frequencies and the
compression ratio. The default predicts the lowest possible setting required to
provide audibility.

¢ Audibility: improves audibility of high frequency sounds by lowering them into a
useable/audible range (more frequency compression)

¢ Distinction: improves distinction of high frequency sounds like ‘s” and ‘sh’ due to
greater separation (less frequency compression)

* Consonant clarity/vowel quality: This slider is dependent on the top slider and is
automatically optimized for clarity but can be adjusted for sound quality.

* Consonant clarity: increases the compressed range for high frequency sounds
(consonants)

* Vowel quality: decreases the compressed range for low frequency sounds (vowels).

Note: The software will automatically calculate the starting default settings for Frequency
Compression 2 based on the client’s better ear audiogram and the fitting formula. To
calculate each side independently go to Pre-Fitting > Frequency Compression Strategy.

Note: With the DSL v5 pediatric fitting formula, Frequency Compression 2 default settings
are more aggressive (i.e. lower cut-off frequency, higher compression ratio) to emphasize
audibility of high frequency speech cues for children.

Note: For clients with asymmetrical hearing loss, the Frequency Compression 2 settings
will be based on the audiometric thresholds from the better ear and applied to both
devices in binaural fittings. To calculate each side independently go to Pre-Fitting »
Frequency Compression Strategy.

Note: The shaded region on the frequency response graphs reflects the Frequency
Compression 2 region. The solid line at the beginning of the shaded region shows the cut-
off frequency for high frequency dominated signals. The dashed line within the shaded
region shows the cut-off frequency for low frequency dominated signals.
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Fitting Advice
1. Click the Fitting Advice task item at the bottom of the screen.

2. Select the program(s) you wish to modify using the program selector list as
described above.

3. Select the situation (type of sound environment) that is problematic for the client
using the Select Situation dropdown box.
Note: If the Difficult Situation Predictions feature is available, the dialog will default
to show the top three predictions. However, you can toggle between this view and
the standard Fitting Advice view (to view the full list of Situation ‘Categories’ and
‘Sound Types’) by clicking on ‘Show Full List” or ‘Show Predictions’.

4. Select the concern that best describes the client’s complaints for that sound type
using the Select Concern dropdown box.

5. Adescription of the proposed change appears on the screen and an associated
sound file is automatically selected by the media player.

6. Ifdesired, play the associated sound file and/or apply the suggested change using
the Apply button. Any previously applied undesirable changes can be removed
using the Undo button.

Tinnitus Masker

This option is available when the product supports this feature. The tinnitus masker
noise is disabled by default. When it is enabled, the quick fit level should be at a soft
but audible level. The calculated masker noise level with the current settings will be
displayed in dB(A) in the task box.

1. Click the Tinnitus Masker task item at the bottom of the screen.

Note: The graph view will automatically change to ‘output’ upon selection of the tinnitus
masker task box to allow you to view the tinnitus masker output level relative to the
hearing aid output settings.
2. Click the Enable Tinnitus Masker check box to activate the masker noise.
3. Click the checkbox beside Use client control to adjust noise level to allow client
to adjust the noise level using any volume or SmartFocus control on the hearing
instruments or accessories. Selecting this option will prevent the client from
adjusting the gain or the SmartFocus setting for this program.

Note: This setting is binaural and cannot differ across hearing instruments in the
same fitting, even if the tinnitus masker is disabled or not available in one hearing
instrument.

4. Select the frequency resolution you require for your modification using the
provided tabs.
Note: The frequency resolution depends on the technology level of the product you
are fitting.

5. Select the frequency region(s) to be modified in the table.
* Toselect anindividual frequency region, select the desired value in the table.

* An entire frequency range of fitting values can be selected by choosing the
‘Noise’ label.
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* To select multiple frequency regions for adjustment, you can also click and drag
across the table. The slider bar along the bottom of the table allows you to view
frequency regions that are outside the visible table area.

* Toview all frequency regions for a particular ear, and/or increase the size of the
selectable boxes in the table, click on the View right ear only or View left ear only
text as appropriate. To change the table view back to a binaural view, click on
the text View both ears.

* Onceyou have selected your desired frequency region for adjustment, click the dB
drop-down menu to alter the step size of any change. Choose from 1, 2 or 3 dB.

* Click the + or — buttons to apply the desired change.

Note: When a fitting handle has reached its maximum setting, the + button will grey out
(disable). Conversely, if a fitting handle is at its minimum setting, the — button will grey
out (disable).

Note: The alerts tab will highlight once the generated masker noise setting reaches

a value of 80 dB(A) or greater to indicate that care should be taken when exposing
the client to continued noise at this level to avoid an adverse impact on hearing.
Arecommended daily usage time based on NIOSH standards (http://www.cdc.gov/
niosh/docs/98-126/) will also be indicated considering the current masker noise level
and updated as the noise level is adjusted. The noise level settings will be limited such
that the generated noise never exceeds a level of 85 dB(A), assuming at least 8 hours
of use / day to address concerns regarding the impact of continued noise exposure on
hearing sensitivity from NIOSH guidelines.

Note: The tinnitus masker settings are global for the Automatic Program (SoundNav/
Integra 0S), so they will be the same in all Automatic Program (SoundNav / Integra OS)
environments, but the settings can vary across manual programs.

Remote adjust

Remote adjust provides the ability to remotely deliver a fitting adjustment to your client
without the need for an in-person fitting. Adjustments are easy to make via the remote
adjust workflow and are sent directly to the client via the Remote Plus app.

You can send multiple adjustments to the client, who can easily switch between the
different adjustments via the app. On detecting the hearing instruments during a follow up
appointment, the Remote Adjust toolbox will show the gain offset values applied on the
hearing instruments.

See the remote adjust guide under the Help/Instruction Guides menu option for more detail.
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Configure Features

Configure Features (Discover Next and earlier products)

Select the Configure Features screen to adjust various adaptive parameters in the
hearing instrument by clicking the desired task item.

Note: MediaNav is new for Discover and Discover Next. As part of SoundNav 3.0, it
allows the hearing instruments to classify specific streamed signals for MediaNav
speech and MediaNav music, both of which can be configured/ fine-tuned similar to
other programs.

Note: Within the configuration boxes for the various adaptive features, both ears are
linked by default. To unlink, click the link / unlink icon within each feature’s task box.

Sound Conductor

This feature is available for products on the North, Tempus, Discover and Discover Next
platforms.

Depending on selected environment / manual program, adjustments to this feature can

impact underlying speech enhancement, noise reduction, and/or directional strength.

Please see feature diagram in software for more information.

1. Select your desired position using the provided slider.

2. The selected number for Sound Conductor will provide different strengths of
underlying parameters depending on the environment.

3. Aspecific setting, such as “3” for Sound Conductor within environments under
Conversations and No Conversations will have different underlying feature
strengths.

Note: On initial arrival at the screen, all values will be set to the default values defined
as per the fitting. If only the blue bar indicator shows this means that the current value
is also the default value. If you change the value, the blue bar still shows the current
value, but a new grey marker appears, providing a visual reference to the default value.

Input

1. Click Input.

2. The available microphone input options depend on the product and program being
adjusted.

Note: For environments that offer mixed inputs (e.g., Telecoil + Microphone, Audio
Streaming + Mic, Direct Audio Input + Mic), the microphone level can be adjusted using
the mic attenuation slider from O to -30 dB with the exception of easy-DAI.

Note: When Binaural Phone is activated, the input selection task box offers the ability
to configure phone ear inputs (Telecoil + Microphone with 0 to -30 dB mic attenuation;
or Omni) and non-phone ear inputs (Audio Streaming + Mic with optional 6 dB mic
attenuation or a mic attenuation slider from 0 to -30 dB available with some products).

Note: Settings for MediaNav environments are shared. Any changes to input will apply
to all environments.

Note: For Discover Next products, the Activation Behaviour for the PartnerMic and
RogerDirect™ programs can be configured here. It is assumed all clients will want this
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set to Automatic. See the TV Connector section in this guide for details on the three
available options of Automatic, Manual or Manual (with beep).

RogerDirect has an additional configuration option, Adaptive Microphone Behaviour.
Hover over the options to see popups explaining the different settings.

Wind Noise Manager / Wind Control

1. Click the Wind Noise Manager / Wind Control.

2. Select your desired wind noise manager strength from the provided options.

AntiShock 2
1. Click AntiShock 2.
2. Select your desired AntiShock strength from the provided options.

Phase Canceller
Select your desired phase canceller strength from the provided options.

Binaural Phone

Note: This feature is available when a telephone program is selected in a binaural fitting
for select wireless products.

1. Click Binaural Phone.

2. Click the Enable Binaural Phone check box to activate this feature.

3. Select the client’s Preferred phone ear when selected using remote from the
provided drop-down menu. This choice impacts the streaming direction when
Binaural Phone is activated using the remote control phone button.

4. Click the HI push button selects phone ear check box to have the system stream
the phone signal in either direction based on which push button was used to toggle
into the Binaural Phone program. That is, the phone ear is identified as the side
which had its push button activated.

Note: When accessing Binaural Phone streaming using easy-t, the phone ear is
automatically identified as the side that triggered easy-t (ie., the ear where the phone
receiver is located).

Note: When Binaural Phone is activated, the input selection task box offers the ability to
configure phone ear and non-phone ear inputs (mic attenuation).

MyMusic

MyMusic is available when a music environment or program is selected.

1. Click MyMusic.

2. Choose one of the default offsets from the provided drop-down menu.

With Discover and Discover Next, you can also configure MyMusic specifically for the
MediaNav music environment. This works the same way as MyMusic does for the Music
program but in this case it is for streamed music.
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Automatic Controls

Note: This option is available when the automatic program or one of its environments
are selected.

1. Click the Automatic Controls.

2. [Ifavailable, select the client’s Highest Priority and Lowest Priority environments
from the provided drop-down menus (these setting are available with some Era
products).

3. Ifdesired, adjust the Sensitivity control using the provided drop down menu to
impact how quickly the Automatic Program / SoundNav responds to changes in the
environment.

Note: The automatic controls should be left in their default positions for the initial fitting
and reviewed later if the client has concerns regarding the instruments’ switching
behaviour.

Note: This feature is global for all environments.

SmartFocus / SmartFocus SP / SmartFocus 2
This feature is available for products prior to the North and Tempus platforms.

1. Click the SmartFocus / SmartFocus SP / SmartFocus 2 Configuration task item at
the bottom of the screen.

2. Select your desired position using the provided slider.
Note: If desired, click on the icon to view the frequency response.

Car with Speech Direction
This program is not available with all models.
1. Click Speech Direction.

2. Use the drop-down menu to change the direction of the speech based on hearing
needs.

Configure Features (Blu products)

Select the Configure Features screen to adjust various adaptive parameters in the
hearing instrument. With Blu, you select the program in the left hand pane and view/
alter the values of the adaptive parameters in the right hand pane.

For adaptive parameters that can be configured monaurally, both ears are linked by
default. To unlink, click the link / unlink icon.
The adaptive parameters are grouped in to three sections:
1. Binaural adjustments only
Adjustments apply to both hearing instruments, or the single hearing instrument (if
the fitting is for only one ear)
* AutoFocus 360/AutoFocus
* Dynamic Noise Reduction (available only with specific technology levels)
* Microphone Mode
e Speech Enhancement
* Noise Reduction
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2. Binaural or monaural
¢ Wind Control
* AntiShock 2
* Phase Canceller
3. Program specific parameters
* Additional parameters that are less frequently changed (outlined below)

For adaptive parameters using sliders, all values will initially be set to the default values
defined as per the fitting. If you change the value, the blue marker bar still shows the
current value, but a grey marker provides a visual reference to the default value.

Slider Controls

Slider behaviour differs based on the selected program type:

* Integra OS program — the single controls globally impact all of the potential blendings
of the underlying environments

*  Media program — the single controls apply to one or both of the Media speech and
Media music programs

*  Manual, Wireless and Optional App Programs — the sliders apply to the individual
program only

Select the Configure Features screen to adjust various adaptive parameters in the hearing
instrument. With Blu, you select the program(s) in the left hand pane and view/alter the
values of the adaptive parameters in the right hand pane.

For adaptive parameters that can be configured monaurally, both ears are linked by
default. To unlink, click the link / unlink icon.

Section 1 — Binaural adjustments only

Microphone Mode

The Microphone Mode slider is used to set the directional strength which increases

as you move the slider from left to right. The system will automatically select an initial
microphone mode based on the fitting. The value of the selected microphone mode will
change on moving the slider and the vertical markers on the slider show the points of the
other available microphone modes. Similar to previous platforms, the selectable values
are Omni, Pinna, Spatial Awareness, Fixed Wide Directional, Fixed Wide, and Adaptive
Directional. However, different to previous platforms, each value on the slider represents
a specific strength, i.e. the slider is a continuous scale, so that any position in between the
two markers represents a continuous change in the directional strength.

Avisual is displayed at the right of the slider providing an approximate visual view of the
directional strength for each setting.

When selecting the Integra OS program, the label of the slider will change to be ‘Max
Microphone Mode’ and you can change the value of the slider to select the maximum
directional strength that will be applied across any of the potential blendings of the
underlying Integra OS environments, i.e. Fixed Wide Directional, Fixed Wide and Adaptive
Directional.

For all other Manual or Optional App programs that support the microphone mode, the
selected slider value represents the fixed value of microphone mode for that specific
program.
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For programs that offer mixed inputs (e.g., Telecoil + Microphone, Audio Streaming +
Mic, Direct Audio Input + Mic), the Microphone Mode slider will be hidden. See section
‘Input source and Attenuation” in Section 3 below for details on mic configuration
options for these programs.

AutoFocus 360, AutoFocus and Dynamic Noise Reduction

AutoFocus is available with technology level 7 products and AutoFocus 360 is available
with technology level 9 products, and the default value is always ‘enabled’.
Note: these controls are only available in binaural fittings.

The controls for Dynamic Noise Reduction and Microphone Mode are mutually
exclusive and only one will ever be enabled at any given time.

AutoFocus 360/AutoFocus = ‘On’

e Dynamic Noise Reduction slider is enabled
*  Microphone Mode slider is disabled
AutoFocus 360/AutoFocus = “Off”

e Dynamic Noise Reduction slider is disabled
*  Microphone Mode slider is enabled

If AutoFocus 360/AutoFocus is enabled, in quieter listening environments, the
microphone mode will be set to Spatial Awareness, but in complex listening
environments the system will take over steering of the directional beamformer,
determine the direction from which speech is coming and focus accordingly.

In complex listening environments where speech is from the front, the Dynamic Noise
Reduction slider can be used to adjust the amount of spatial cancellation being applied
to minimize noise from the rear to improve the overall SNR.

Speech Enhancement and Noise Reduction sliders

Speech Enhancement slider will automatically select an initial recommended level
based on the fitting and allows you to set the maximum level of speech enhancement
that can be applied in each program up to @ maximum of 6 dB. The scale always shows
a maximum of 6 dB, but the maximum selectable value differs per technology level,
and for lower technology levels the upper range of the slider will be greyed out as
appropriate.

Integra OS — the selected value will be the maximum applied across any of the potential
blendings of the underlying Integra OS environments.

Media — the selected value will be the maximum applied across both Media
environments i.e. Media Speech and Media Music.

Manual, Wireless or Optional App programs - the selected value represents the
maximum speech enhancement that can be applied for that specific program.

Car with Speech — has an asymmetric configuration applied to a binaural set of Hearing
Instruments. The speech enhancement will be configurable for the ‘listening side’ ear
(i.e. the ear facing the driver or the passenger) but will always be set to zero for the ‘non-
listening ear’ (i.e. the ear facing the window).

Noise Reduction slider will automatically select an initial recommended level based
on the fitting and allows you to set the maximum level of noise reduction that can
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be applied in each program up to a maximum of 10 dB. The scale always shows a
maximum of 10 dB, but the upper selectable value differs per technology level, and for
lower technology levels the upper range of the slider will be greyed out as appropriate.

Integra OS — the selected value will be the maximum applied across any of the
potential blendings of the underlying Integra OS environments. The one exception is the
music environment, where the value will always be 0 dB.

Media — the selected value will be the maximum applied across Media Speech only.
The value for Media Music is always 0 dB, regardless of the NC slider setting

Manual, Wireless or Optional App programs — the slider control selected represents the
maximum noise reduction that can be applied for that specific program.

Shared controls

If the client uses the Remote Plus app, they will have the ability to make persistent
changes in any Manual programs you have added to the fitting, or any Optional App
programs that they may have added themselves via the app. In a follow up fitting any
changes made by the client will be reflected in Unitron TrueFit and you will be able to
alter these as required. The client can alter the following parameters:
*  Microphone Mode — the client will only ever see one slider in the app which
will correspond to either the Microphone Mode control, or the Dynamic Noise
Reduction control (if AutoFocus 360/AutoFocus is available and enabled in Unitron
TrueFit)

*  Speech Enhancement
* Noise Reduction

The client does not have the ability to make any persistent changes in the Integra OS
program.

Section 2 — Binuaral or monaural

Wind Control, AntiShock 2 and Phase Canceller

For each of these controls, the slider is used to set the value, the strength of which
increases as you move the slider from left to right. The system will automatically

select an initial value based on the fitting. The points on these sliders range from O

to 10, where the strength of the control increases as you move from a minimum of

0 to a maximum of 10. On hover over/drag, four vertical markers show on the slider

to indicate points that equate to the values that were selectable for these controls in

DX and earlier platforms, i.e. 0 = Off, 3 =Mild, 7 = Mod and 10 = Max. Different to
previous platforms, each value on the slider represents a specific strength, i.e. the slider
is a continuous scale, so that any position in between the markers represents a change
in the strength of the control.

Section 3 — Program specific parameters

Any adaptive parameters which are not applicable to ALL programs are listed in this
section including the programs where they apply. The controls will be displayed when
applicable and configurable for the selected program.
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Soft Speech Lift

Soft Speech Lift is enabled by default. The control to enable/disable Soft Speech Lift is
hidden by default. To change the value, you will first need to show the control via the
Options > Preferences » Fitting Session » Fitting screen. Soft Speech lift is available for
the following programs:

* Integra OS
*  (Conversation in quiet
*  Quiet

e Speech from Mask
*  Acoustic Telephone
e Place of Worship

Input source and Attenuation

For audio streaming programs that offer mixed inputs (e.g., Telecoil + Mic, Audio
Streaming + Mic), the input source can be limited to either the audio stream only, or the
audio stream plus the mic. If the input source includes the mic, you can also adjust the
mic attenuation. These controls are available for the following programs:

*  Media

* PartnerMic

*  Bluetooth Phone

* RogerDirect

* Loop System

e Acoustic Telephone
e Telephone

Activation Behaviour

See the TV Connector section in this guide for details on the three available options of
Automatic, Manual or Manual (with beep). The Activation Behaviour can be set here for
the following programs:

* PartnerMic

* RogerDirect

Sensitivity

If desired, adjust the Sensitivity control using the provided drop down menu to impact
how quickly the Integra OS program responds to changes in the environment. This is
only applicable to the Integra OS program.

Adaptive Microphone Behaviour

This is a configuration option specifically for the RogerDirect program. Hover over the
options to see popups explaining the different parameters.

Speech Direction

This configuration option applies to the Car with Speech program only.

Use the Speech Direction control to select if the user’s preferred role is that of a driver or
a passenger.
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Speech direction can be either ‘Speech from Right’ or ‘Speech From Left’ based on
whether the client is the driver or a passenger. In either case, the direction of speech
always comes from the interior side of the vehicle as opposed to the external (window)
side of the vehicle. The speech direction for the driver will always be opposite the
setting for the passenger, i.e. if driver is ‘Speech From Right’, passenger will be ‘Speech
From Left’, and vice versa.

The assignment of speech direction side is derived from the side of the road that cars
drive on in the country selected at time of Unitron TrueFit installation. For example the
speech direction options will be as follows:

If driving on the left side of the road (e.g. selected United Kingdom on installation)

*  Driver (Speech From Left)

*  Passenger (Speech From Right)

If driving on the right side of the road (e.g. selected United States (USA) on installation)
*  Driver (Speech From Right)

* Passenger (Speech From Left)

The microphone mode parameters for the Car with Speech program are fixed as
follows:

* Earfocusing on speech — Omni
e Earnot focusing on speech — Adaptive Directional

Binaural Phone
These configuration options are specifically for the Acoustic Telephone program.

Enable Binaural Phone — select to enable

HI Push button selects phone ear — select to allow the client to dynamically select the

primary ear for a phone call by pressing the left or the right Hearing Instrument push

button to toggle in to the Binaural Phone program. The phone signal is then streamed

to the opposite ear.

Preferred Phone Ear — select the client’s preferred phone ear to use when:

e Selected using the phone button on the remote control

*  Selected via the Hearing Instrument push button (if the ‘HI Push button selects
phone ear option is not selected)

Mic Attenuation — when binaural phone is enabled, available for the non-phone ear

only.

Microphone mode — binaural phone is enabled, setting is static for each ear as follows:

¢ Phone ear— Omni

*  Non-phone ear — Audio Streaming + Mic

Microphone mode — binaural phone is disabled, you can select from two microphone
mode options of omni or mute
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Phase Canceller for Music

As already stated, the setting of the Phase canceller slider is global across all
environments of the Integra OS program. This control allows you to disable the phase
canceller specifically for the Music environment of the Integra OS program.

Program Manager

Select the Program Manager screen to add or remove additional manual programs,
copy programs, rename programs, change program order, and assign easy-t / easy-DAI
access (when applicable).

To add programs to the manual program list:

e Select the program name under the Available Programs list or click the arrow next
to the program name OR

e Click the Copy icon beside the program that you would like to copy from the
Selected Programs list.

To remove manual programs:

e Click on the Delete icon next to the program in question.

To rename programs:

e C(lickthe program name under the Selected Programs header.

To assign easy-t to a program in devices supporting this feature:

e Add atelephone program that has easy-t capability and select the easy-t check
box beside that program in the column list.

Note: Easy-t can only be assigned to one telephone program.

To assign easy-DAl to a program in devices supporting this feature:

* Adda DAl program and select the easy-DAI check box beside that program in the
column list.

Note: Easy-DAIl can only be assigned to one DAl program.

To reorder manual programs:

e Click on the Move Program Up or Move Program Down icon next to the program in
question.

Note: To select which program is the start-up program, go to the End Fitting » HI Setup »
Startup Settings task box. By default, the Automatic Program (SoundNav / Integra OS)
is the start-up program when it is included in the program toggle sequence. To remove
the Automatic Program (SoundNav / Integra 0S), easy-t and/or easy-DAl from the
program toggle sequence, go to End Fitting > HI Setup > Program Toggle task box.

Note: Mute program is only available for some products. If the mute program is not
available, then create a quiet program and then change the Input strategy under
Fitting » Configure Features to mute.

Feedback Optimization

Select the Feedback Optimization screen to run the feedback test.
1. Click the Start Feedback Test button.
2. Follow the on-screen instructions to perform feedback optimization. The status of
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the test appears above the graph (complete, incomplete, not run). In cases where
the environment may have impacted the test (e.g., excess noise present), the

final results include a combination of measured values and predicted feedback
threshold values. The status then indicates Incomplete. Repeating the test will
replace any predicted values with measured values if they can be reliably obtained
in the current test environment.

Once the feedback test is completed, the hearing instrument’s gain is limited as shown
on the graph where:

* Black line = feedback threshold

*  Grey line = hearing instrument gain limit

* Green line =target gain for 50 dB pure tone input

* Red orBlue line = aided gain for 50 dB pure tone input

Note: If desired, the feedback test can be deleted using the Delete icon above the graph
for the device / ear in question.

Note: The phase canceller is enabled prior to running the feedback optimization test
and the quick fit will be limited to the predicted maximum stable gain. Following the
feedback test, the device is automatically quick fitted up to the desired adaptation
manager level setting, but not beyond the measured maximum stable gain curve.

Note: For some products, after running the feedback optimization test the gain limit of
the hearing instrument can be increased by up to 5 dB by clicking the checkbox under
the graph for that instrument.

Automatic REM

Automatic REM (introduced with the launch of Discover Next) integrates an automated
workflow for REM with the Otometrics Aurical FreeFit solution, providing users with a
seamless, step by step workflow that takes advantage of the features of the Auricle
FreeFit solution while allowing the real ear activities to be performed from within the
Unitron TrueFit software. This creates an easy and effective way of incorporating REM
into the fitting process.
In summary, the Unitron TrueFit integration will guide you through the process of:
e  Probe tube calibration
e Performing:

* Real Ear Unaided Gain (REUG)

* Real Ear Occluded Gain (REOG)

* Acoustic Coupling (Ear-to-Coupler Level Difference ECLD)

* Real Ear Aided Gain (REAG)

* Microphone Location Effect (MLE)
e Automatic target matching
Automatic REM can be run on Tempus products onwards.

See the Automatic REM Guide under the Help/Instruction Guides menu option for more
detail.
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End Fitting menu
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HI Setup

Select the HI Setup screen to configure the function of the user controls on the hearing
instrument (e.g., push button, multi-function button, push button / rotary dial and lever /
dial) along with the activation of DuoLink (binaural wireless coordination) for each of these
controls. In addition, HI setup allows you to adjust other hearing instrument parameters
by clicking on the desired task item at the bottom of the screen. These options include
Bluetooth, TV Connector, Volume Settings, Startup Settings, Data Logging and Program
Toggle Exceptions.

Push Button

To configure the functionality of the push button (when available), select the desired
item from the drop-down menu

*  No function: the push button is disabled on the hearing instruments.

e Program change: press the push button to toggle through the various listening
programs.

*  Volume up: pressing the push button increases the volume in steps. Once the
hearing instrument reaches the maximum volume, the next step will bring it back
to the default volume level.

*  Volume down: pressing the push button decreases the volume in steps. Once the
hearing instrument reaches the minimum volume, the next step will bring it back to
the default volume level.

* Right louder / left softer: pressing the push button on the right device increases the
volume for both hearing instruments. Pressing the push button on the left device
decreases the volume for both hearing instruments.

Note: DuoLink must be on for this setting to function.

*  Volume up / Program change: pressing the push button on the right increases the
volume in steps; once the hearing instrument reaches the maximum volume, the
next step will bring it back to the default volume level. Pressing the push button on
the left changes the program.

Note: DuoLink must be on for this setting to function.

*  Program change / Volume down: pressing the push button on the right changes
the program. Pressing the push button on the left decreases the volume in steps;
once the hearing instrument reaches the minimum volume, the next step will bring
it back to the default volume level.

Note: DuoLink must be on for this setting to function.
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e  SmartFocus: R clarity, L comfort - pressing the push button on the right device moves
the SmartFocus setting towards clarity for both hearing instruments. Pressing the
push button on the left device moves the SmartFocus setting towards comfort for
both hearing instruments.

Note: DuoLink must be on for this setting to function.

Note: The program toggle on the remote is not impacted by the setting of this control.

Note: Some hearing instruments support a short press and a long press. You can configure
them separately on this screen.

Multi-function button

To configure the functionality of the multi-function button (if available):

*  With the multi-function button on Discover, Discover Next and Blu hearing
instruments, you simply check or uncheck the different button functions and Unitron
TrueFit applies pre-defined rules to assign functions against the button behaviours. In
addition, there is the possibility to add Mute which has its own dedicated function.

Note: there is no ability to split functions between the ears, i.e. the defined button behaviour
is the same whether pressing the buttons on the left or the right hearing instrument.

Show Behaviour

There are five defined behaviour options for the hearing instruments where settings can
be assigned, i.e. Standard, Streaming (during notification), Streaming, Bluetooth phone
(ringing) and Bluetooth phone (call). Selecting one of the five options updates the Button
Behaviour display to show the current functions assigned to each of the Up/Down presses
for both the Long Press and Short Press options for the selected behaviour.

Button Behaviour

Shows the associated settings for the selected behaviour indicating whether the behaviour
is associated with an Up press, a Down press or both.

Button functions

You can select which button functions are to be enabled on the hearing instruments,
choosing from the four available options of Volume, Program Change, Accept/reject call or
Mute/unmute mic.

The following matrix shows which Button Functions can be activated with each of the
hearing instrument behaviours.

Volume Program Accept/ Mute/unmute
change reject call mic
Standard Y Y N Y
Streaming (during notification) N Y Y Y
Streaming Y Y N Y
Bluetooth phone (ringing) N N Y N
Bluetooth phone (call) Y N Y N

Note: Streaming (during notification) is only shown when one or more streaming programs
has an Activation Behaviour setting of ‘Manual (with beep)..
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Button function priorities

Button functions have a defined priority ranking and the function with the highest
priority ranking is always allocated to the Short press button options.

The following matrix shows the Button Function priorities applicable for the Standard
and Streaming behaviours:

Selected Button press Selected Button press Selected Button press

Volume (1) Y Short N - N
Program Change (2) Y Long Y Short N
Mute/unmute mic (3) Y Long Y Long Y Short

The following matrix shows the Button Function priorities for the Bluetooth Phone (call)
behaviour. If volume is selected, it is assigned to Short press and End Call is assigned to
Long press. If only Accept/Reject call function is selected, End Call is assigned to both
Short and Long press

Selected Button press Selected Button press
Volume (1) Y Short N
Accept/reject call (2) Y Long Y Short & Long

For Bluetooth Phone (ringing), the only available function is Accept/Reject call. If
selected, Short press is assigned to Accept Call and Long press is assigned to Reject
Call.

Note: the “mute” function is only available for Streaming and Standard behaviours as it
serves the purpose of blocking the environment by muting the hearing aid microphone.
It is not available during a phone call as if you cut access to the hearing aid microphone
you deactivate own voice pick up.

Tap functions (Blu hearing instruments only)
Tap control can be configured to:
*  Accept/end phone call - double tap on either ear

*  Pause/resume streaming - configure for left ear only, right ear only, or both ears. If
you select ‘both ears’, the control for Start/stop voice assistant is disabled

*  Start/stop voice assistant - configure for left ear only, right ear only, or both ears. If
you select ‘both ears’, you the control for Pause/resume streaming is disabled
Click Tap control training to allow the client to try out the double tap gesture.

Note: tap functions are only available on Blu rechargeable hearing instruments.

Push button / rotary dial

To configure the functionality of the push button / rotary dial (if available):

e With the push button and rotary dial on Discover Next wireless ITE hearing
instruments, you simply check or uncheck the different button or dial functions and
Unitron TrueFit applies pre-defined rules to assign functions against the button or
dial behaviours. In addition, there is the possibility to add Mute which has its own
dedicated function.
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Note: there is no ability to split functions between the ears, i.e. the defined button
behaviour is the same whether pressing the buttons on the left or the right hearing
instrument.

Show Behaviour

There are five defined behaviour options for the hearing instruments where settings can
be assigned, i.e. Standard, Streaming (during notification), Streaming, Bluetooth phone
(ringing) and Bluetooth phone (call). Selecting one of the five options updates the
Button Behaviour display to show the current functions assigned to each of the short
press, long press, or rotary dial options for the selected behaviour.

Button Behaviour

Shows the associated settings for the selected behaviour indicating whether the
behaviour is associated with a short press, long press or a turn of the rotary dial.

Button Functions

You can select which button functions are to be enabled on the hearing instruments,
choosing from the four available options of Volume, Program Change, Accept/reject call
or Mute/unmute mic.

Dial Function

If the hearing instrument configuration includes a rotary dial, this is the only way to
control the volume on the HlI, i.e. the volume function cannot be applied to either a short
or long press of the push button.

Lever / dial

To configure the function of the lever / dial on the hearing instrument(s) (if available):

*  Click the drop-down menu under the lever / dial label on the primary screen.

Choose from:

*  Volume Control: the lever / dial adjusts the volume level of the hearing instruments.
Note: DuoLink is disabled by default to allow independent adjustment of this
control on each ear.

*  SmartFocus: the lever / dial adjusts the SmartFocus setting in the hearing
instrument.

Note: DuoLink is disabled by default to allow independent adjustment of this
control on each ear.

*  No function: the lever / dial is disabled on the hearing instrument.

Note: The + / — buttons and scroll wheel on the Smart Control remote are not
impacted by the setting of this control.

Note: Only one user control on the hearing instrument can be assigned to perform a
particular function. While both the push button and lever/dial can be configured as
either a volume control or a SmartFocus control, both controls cannot perform the same
function.
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IIC / Micro CIC remote

To configure the function of the IIC remote / micro CIC remote (if available):
1. Click the drop-down menu under the IIC / Micro CIC remote function label on the
primary screen. Choose from:

* No function: the IIC / micro CIC remote is disabled.

* Program change: bring the remote up to each hearing instrument to toggle
through the various listening programs.

* Volume up: bring the remote up to each hearing instrument to increase the
volume in steps. Once the hearing instrument reaches the maximum volume,
the next step will bring it back to the default volume level.

* Volume down: bring the remote up to each hearing instrument to decrease the
volume in steps. Once the hearing instrument reaches the minimum volume, the
next step will bring it back to the default volume level.

Bluetooth

Bluetooth name: the name of the hearing instrument as seen by other Bluetooth
devices. If no name is set a default value is used.

Phone ear: configure the hearing instrument that will be used to handle phone calls. If
this value is changed, the newly selected hearing instrument will need to be paired to
the user’s phone after the fitting session has been closed.

Enable adaptive bandwidth: for Discover and Discover Next only, when conducting a
Bluetooth phone call, some phone models result in a user experience where the call
recipient hears either garbled or no audio. Disable this feature to resolve the issue.
Note: The Bluetooth name is visible to any Bluetooth device. Be mindful of sensitive
information such as client names or personal information when naming the device.

TV Connector

Direct connectivity hearing instruments can connect directly to the TV Connector

accessory and you can configure how the devices will behave when they come into

range of a TV Connector.

When a TV Connector stream is detected, the associated activation behaviour for each

option is as follows:

* Automatic - the TV Connector stream is activated automatically

*  Manual - the TV Connector stream is added as the last manual program. (Note: the
‘Manual’ feature is not available for Moxi All.)

*  Manual (with beep) —a beep is heard and the TV Connector stream is added as the
last manual program. Additionally with this option, a short press within 15 seconds
after the beep will skip all programs and jump directly to the stream.

Note: Default behaviour is ‘Automatic’, and you can hover over the text to see a popup

explaining the behaviour.



Unitron TrueFit software instruction guide v5.1

Volume Settings
1. Click the Volume Settings task item at the bottom of the screen.

2. Select the desired amount of increase in volume using the Volume Control Up drop-
down menu.

3. Select the desired amount of decrease in volume using the Volume Control Down
drop-down menu.

Note: The value selected in the volume control up and down boxes determines the
volume control range provided to the client (as displayed in the volume settings
task box). Each adjustment of the volume control using a remote or on the hearing
instruments is 2 dB.

Start up Settings

1. Click the Start up Settings task item at the bottom of the screen.
2. Select the desired Start up Program from the drop-down menu.
3. Select the desired Start up Delay from the drop-down menu.
4

For Li-ion rechargeable units, you can enable/disable the automatic behaviour to
turn the units on when removing them from the charger unit.

Data logging
1. Click the Data logging task item at the bottom of the screen.

2. Select the desired data logging and learning parameters (if applicable) from the
drop-down menu.

Program Toggle Exceptions
1. Click the Program Toggle Exceptions task item at the bottom of the screen.

2. Uncheck the boxes to indicate which of the following you would like to exclude from
the program toggle sequence:

* The Automatic Program (SoundNav / Integra OS)
* The easy-t program (if applicable to the product being fitted)
* The easy-DAIl program (if applicable to the product being fitted)

Beeps

Select the Beeps screen to demonstrate and configure the various user notification
beeps in the hearing instrument. These options include beep setup, beep enabling, and
trial duration (FLEX devices only).

To demonstrate beeps:

There are a number of play buttons for various user notifications. Depending on the

product being fitted, you have the option of playing beeps associated with:

*  Program Change: choose the desired program to demo using the drop-down menu.

* Easy/Automatic Events: choose from Easy-t, uPhone activation, uAudio Bluetooth
activation, uAudio audio jack input activation, uFM activation, or Smart Control
telephone button activation.

*  Warnings / Alerts: choose from low battery, LearnNow (if applicable), Smart Alert
notification alerts (if applicable) and TV Connector available (if applicable).
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Trial Duration: play the ‘End of trial period” beeps that will be generated in FLEX
devices once the trial period has expired.

e Connection Alerts: choose from Connection lost, and Connection found.

*  Volume / SmartFocus: choose from: volume min/max, volume ideal (default),
SmartFocus min/max, SmartFocus ideal (default), volume step change, SmartFocus
step change.

*  Phone Ring Tones: play provided ring tone.

e Startup Sound: play the startup sound.

Note: The phone ring tone notification is generated during uPhone activation with phones

supporting this feature.

To play the selected notification through the hearing instrument, click the right or left play

buttons beside the chosen drop-down menu.

Beep Setup
1. Click the Beep Setup task item at the bottom of the screen.

2. Select the intensity level from the drop-down menu. Choose from: Very Soft, Soft,
Moderate, Loud, or Very Loud.

3. Select the frequency from the drop-down menu. Choose from: Low, Medium or High.

Beep Enabling
1. Click the Beep Enabling task item at the bottom of the screen.

2. Select the beep notification types you would like active for the client. Choose from:
Program Change, Start Up Sound (initial sound which occurs upon the powering up
of the hearing instruments), Easy / Automatic Events (events listed under the demo
drop-down menu for this category), VC & SmartFocus Min/Max or Volume Control
Min/Max (end of range), VC & SmartFocus steps or Volume Control steps (beeps that
occur each time these user controls are changed), Warning / Alerts (events listed
under the demo drop- down menu for this category), and Connection Alerts (beeps
when a hearing instrument loses wireless connection to its contra-lateral partner, or
when a reconnection is made).

Note: The beeps that play at the end of the trial period with FLEX hearing instruments
cannot be disabled. When the end of trial period beeps start to sound, you can turn off
the repeated beeps by resetting the trial period, i.e. by detecting and then saving to the
hearing instruments.

Trial Duration

Note: This option is available with FLEX devices.

1. Click the Trial Duration task item at the bottom of the screen.

2. Select the desired trial duration before the ‘End of trial period’ beeps are generated in
the hearing instruments.

Note: Once the trial duration has been exceeded, repeated beeps (End of trial period beeps)
will be generated. Initially, these beeps will occur every hour for ~ 3 days of use, after
which the instruments will repeatedly generate the beeps every minute.
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Insights Setup

The Insights Setup screen provides an easy way for you to enable Insights for you and your
clients.

The first two steps are one time only activities to Create/Sign in to your myUnitron account and
to enable Insights for your myUnitron account.

Following detection, hearing instruments are automatically enabled to allow Insights activation.
Once you have saved to the hearing instruments, the client can complete the setup process

by selecting to ‘Activate’ Insights when initially setting up their Remote Plus app. Once the
client has completed this step, the next time you open a session for that client you will see
confirmation that activation is complete. Once this is done, the following features will be
enabled:

*  Remote adjust

e Coach

* Ratings

Finally, selecting to add the client to mylnsights will allow you to view your client’s Log It All,

ratings, usage and satisfaction data in the mylnsights portal. To complete this step you will
need to ask for your client’s consent to store their name and email in the Sonova cloud.

Note: this last step is optional i.e. it is not mandatory that this be done in order to complete the
Insights activation for a client.

Client Language Preference

In this task item, you can configure the client preferred language when they receive emails
from Unitron. The selection will default to the language that is currently used in Unitron
TrueFit. If language is not in the list, it defaults to English. Changing the client language
does not change Unitron TrueFit language in Preferences.

Client Email Address

In this task item, you can either add a new or edit an existing email address. This email will
be used for sending Overall Satisfaction Emails to the client.

When running TrueFit in standalone mode, if an email address already exists in the Client
Record, that email will automatically be pre-loaded to this task item. Any changes made to
the email address via this task item will overwrite any email address currently stored in the
Client Record.
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Fitting Summary

The Fitting Summary screen provides a succinct overview of primary fitting-related items in an
easy-to-read table for each hearing instrument. The table provides an opportunity for a final
check of the fitting settings and general status prior to printing, saving and closing the session.

The default table information is dependent on the product being fitted and can include:
Program List, Client Controls, General Status, Accessories, and Indicators. If desired, additional
details can be viewed by clicking the More Info button which then displays Fitting Settings and
Acoustics.

To end the fitting:

1. Select the check boxes for the items you would like to print (e.g., Fitting reports, Getting
Started Guides for hearing instruments and accessories, if applicable). The client’s
language for the Getting Started Guides can be selected. Click the Send Email or Print
buttons to provide materials to your client.

2. Clickthe Save button. Select the check boxes for the items that you would like to save
(e.g., Save to hearing instruments, Save to database, Save to accessories) on the save
dialog pop-up window. Click Save and then Close in the save confirmation window.

Note: Clicking the Save icon on the primary tool bar or accessing the Save function in the
main menu also provides the ability to save to the hearing instruments, database, and
accessories.

3. To close the session, click the Close Session button. If you have not yet saved the fitting,
the save dialog pop-up window will appear. When running Unitron TrueFit under NOAH
click the Exit Unitron TrueFit button.

4. After closing the session:

* IfusingiCube I, restart your hearing instrument(s) by opening and closing the battery
door(s).

*  Ifusing NOAHIlink or HI-PRO, remove the programming cable, insert the batteries and
close the battery door.
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Insights menu

Client

Instruments @

Fitting 000 (©

End Fitting :

In Sighfs Usage Log It All Ratings

Observe either clients’ usage patterns, Lifestyle or Ratings in this menu. At the initial fitting,
no Usage (also known as data logging) or Log It All (also known as Lifestyle information) will
be available. Log It All and Ratings are only available for North platform products and newer.

Overview

The overview screen provides an at a glance view of the clients usage, lifestyle and
experience with their hearing instruments.

The left hand pane of the screen shows:

History
A drop down of time stamped dates of previous sets of Insights data.

Quick Links

Buttons linking to commonly used features in follow up fittings:
*  Soft/Mod/Loud Controls

*  MPO/Gain/CR Controls

* Adaptation Manager

*  App Equalizer

Difficult Situation Predictions

Your client’s data is fed in to a Machine Learning model trained with anonymized client
usage, fitting and demographic data gathered from thousands of user sessions where the
Fitting Advice tool has been used to indicate a plain-language, situational ‘Sound Type’
that was of concern to their client. The model produces a prediction of the top 3 difficult
‘sound types’ that your client may be likely to experience.

NOTE: this feature is only available for users who have the TrueFit improvement program
turned on and who have an active internet connection.

Usage (Data logging)
Bar chart

The bar chart located in the centre of the screen shows the % of time spent in automatic
and manual programs. For products without an automatic program, the bar chart will
show the % of time spent within each manual program. Data is averaged across left and
right hearing instruments to simplify the information in the table. Ear specific data logging
can be found in the table located immediately below the bar chart.
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Table

This table provides information related to average usage and volume control
adjustments across all programs. When activated, this table will also provide
information related to tinnitus masker adjustments.

In the case of logged data, you can selectively apply logged data to the automatic
program, manual programs, or the wireless programs with the exception of tinnitus
masker. Adjustments to the tinnitus masker can only be made manually under Configure
Features.

Note: Products with self learning will have a remove button.

Ratings icon

The Ratings icon, which looks like a speech bubble, will appear beside any environment
or program having Ratings associated with it. You may click on these to view the
ratings.

History

You have the option of viewing data logging history from previous sessions. To do so,
select the desired session within the drop box provided.

Usage

The usage summary in the left pane provides an average number of hours each hearing
instrument has been worn per day, based on the number of days between sessions.
Log It All

The Log It All feature allows clinician to view the clients listening environments across all
7 environments regardless of the technology level of the hearing instrument worn.

Log It All bar chart

The bar chart is generated based on the percentage of time the client spent in each
type of listening environment. Colored sections of the graph indicate their availability
forthe technology level selected.

History

Allows you to view Log It All history from previous sessions. To do so, select the desired
session within the drop box provided.

Technology Level

Clicking a technology level other than the currently selected level will a) update the
bar chart to indicate the listening environments available at that technology level, and
b) update the feature list to show the differentiation in features between the current
technology level and the selected technology level.

Ratings icon

The Ratings icon, which looks like a speech bubble, will appear beside any environment
or program that has ratings associated with it. You may click on these to view the
ratings.
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Ratings

The Ratings feature allows clinicians to view the ratings and comments clients made
using the remote control apps. The clinician can view these ratings even if the client is
not in the clinic by opening the last client session and navigating to this screen.
Timeline View

The timeline view displays an overview of the positive and negative moment ratings of
the client over time. Clicking on a date will open the ratings for that date. Clicking on a
specific rating will display that rating on the client screen if that option is selected on
the Quick View Pane; clicking on that same rating will toggle off the view of that rating
on the client screen.

Moment Ratings

The moment ratings view displays the same client ratings grouped according to the
situation selected by the client for each rating. Clicking on one of the client situations
will open the ratings related to that situation. Clicking on a specific rating will display
that rating on the client screen if that option is selected on the Quick View Pane; clicking
on that same rating will toggle off the view of that rating on the client screen.

Each moment rating has up to 9 pieces of information related to it:

* Moment rating: positive / negative

e Date and time of the moment

e Client-selected situation

e Comment

*  Hearing instrument program

* Log It All environment

*  Volume settings

*  Mic attenuation settings

*  AAM settings

Note: The Ratings feature requires an internet connection.

Curve display options

All of the curves displayed from Unitron TrueFit v3.1 onwards are based on targets that are
generated assuming a speech input instead of the pure tone inputs previously used.

On any screen displaying a graph, you can change the items shown by clicking the curve
display icon above the upper right graph. Adjustments made here are applied to both the
left and right graphs.

Depending on the section of the software, you will have the option of choosing:

Gain: insertion gain, real-ear, 2cc or ear simulator. Also, option of showing feedback
threshold obtained during the feedback test.

Output: HL real-ear, SPL real-ear, SPL 2cc or SPL ear simulator. Also, option of showing
HTL (hearing threshold) and UCL (uncomfortable loudness) data.

Input / Output: SPL real ear, SPL 2cc or SPL ear simulator, each available at
5,1,2,4,6,8kHz
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e Audiogram: displays current audiogram used in software

e Show target: displays the target curve for the current view

*  Show calculated response: displays the original quick fitted hearing instrument
response for the current view

*  Verification graph: (available in Pre-Fitting screen only if selected under Options >
Preferences » Fitting Session » Fitting) displays hearing instrument response and target
curves based on speech inputs at 50 / 65 / 80 dB SPL. You have the option of showing
curves in gain (insertion gain; 2cc coupler) or output (SPL real-ear)

Note: When the mouse cursor is positioned over items on the graph, a legend appears
providing further details related to that item.

Main Menu

The main menu is available at the top of each screen and consists of these options:

File
Import Client: (standalone only): imports previously exported Unitron TrueFit client data.
After selecting this option, you must select the source file location from the provided
window.
Export Client: exports Unitron TrueFit client data from the software. After selecting this
option, you must choose the destination and name of the exported file. Export options
include:
* Exportall clients: exports all client files from the Unitron TrueFit database
*  Exportanonymously: removes client name from the exported file and assigns an

‘anonymous’ file name identifier.

*  Export to NOAH: exports client file in a format that can be imported into NOAH.
Print: opens a window that shows the documents available such as the Fitting Reports
and the Getting Started Guides (hearing instruments and accessories, if applicable).
The client’s language for the Getting Started Guides can be selected. The selected
documents can be previewed, printed or saved from this window.
Send Getting Started Email: opens a window that shows information that can be sent to
the client.

Software Updates: opens the Welcome Screen to the Software Updates tab.

Save: saves the current fitting information. Choose from Save to hearing instrument,
Save to database, or Save to accessories (if accessory added to fitting).

Close Session: exits the current open session. You will be prompted to save if you
haven’t done so already.

Close Unitron TrueFit: exits the software application. You will be prompted to save your
fitting information if you have not done so before closing Unitron TrueFit.
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Forms

Repair Form: follow the on screen instructions to complete a repair form.

Remake Form: follow the on screen instructions to complete a remake form.

Loss and Damage Form: follow the on screen instructions to complete a loss and
damage form.

Online Order Forms: opens a browser to the correct page on the Unitron website so you
can print out an order form.

Online Repair Forms: opens a browser to the correct page on the Unitron website so you
can print out a repair or remake form.

Hearing Instrument

Save: saves the current fitting information. Choose from Save to hearing instrument,
Save to database, or Save to accessories (if accessory added to fitting).

Test Mode: sets the hearing instrument into a test mode so you can compare the
electroacoustic performance of the device to the published ANSI / IEC specification
data sheets.

Verification Mode: Sets the hearing instrument into a verification mode to allow testing

without the interference of adaptive features. There are 3 options:

*  Adaptive features active: default state.

*  Real Ear Verification: all adaptive features are disabled except for Natural Sound
Balance and input selection.

e 2cc Coupler Verification: all adaptive features and input selection are disabled.

HI Update: checks if newer functionality is available for the connected hearing

instrument. If an update is available, the instrument maintains its fine tuning and new

features become enabled.

HI Repair / Reset: opens a wizard to reset the firmware of a hearing instrument. Only

use this when directed by an error message. If this was not successful, please try again

before sending the hearing instrument back to your distributor. The client record stored

in the database will not be affected.

Transfer Fitting: provides instructions on how to transfer a fitting to or from another

hearing instrument.

Delete Wireless Pairing: Deletes all pairings with phones or TV Connector on the hearing

instruments.

FLEX:TRACKER Device Registration: opens a wizard to walk through the steps to register
the connected device with your FLEX:TRACKER profile
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Options
Preferences

Generates the user preferences dialog box with the following options:

General

* Language and Region: select the preferred language for text and sound files.
Driving orientation can be selected for your country.

e  Presentation: select your preferred level of animations.

*  Support: enable/disable logging of a) Unitron TrueFit information for support, and
b) anonymous usage data for the Unitron TrueFit Improvement Program

* myUnitron: Register myUnitron account and enter myUnitron user name and
password. Required in order to use Ratings.

*  FLEX: Choose the appropriate trial period defaults for FLEX:TRIAL and
FLEX:UPGRADE. Options to enable/disable FLEX:-TRACKER with option to ask for
appointment dates.

* Insights: here you can enable or disable the Insights feature.

*  Email templates: create your own email template when sending support
information to client.

*  Software Updates: enable/disable options to automatically check for and download
software updates

* Internet: configure internet connection settings

Fitting Session
*  Diagnostics: choose the preferred bone conduction symbol and view/adjust the
DSL v5 ABR nHL to eHL correction values.

*  Fitting: indicate if the speech verification graph option will be available from the
curve display options on the Pre Fitting screen. Under tuning, selecting the check
box will display TK for soft speech on tuning screen. Configure Features — allows you
to display the option to Enable Soft Speech Lift and set the value to on or off. Initial
Configuration — allows you to enable/disable the automatic display of the Initial
Configuration workflow following detection of new hearing instruments. Choose
whetherto enable password protection to keep fitting information confidential.
Following activation of this option, you can insert their desired password into the
software. If the Unitron TrueFit software version you are using does not have the
same password as the one saved to the hearing instrument, you will be required to
enter the correct code to proceed with the fitting. Note: Password protection prevents
reading of information from a hearing instrument but does not prevent a clinician from
creating a new fitting on that same device. Certain features can be activated using a
feature activation key.

*  Presentation: select the preferred tuning values display (@absolute or relative);
select visibility options for CR values; hide or show preparation instructions for
the feedback wizard and the in situ test wizard; select whether or not the pediatric
fitting mode recommendation pop-up box is displayed; and choose whether or not
to maintain the aspect ratio of graphs.
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*  Pediatric Modes: View and / or edit the fitting mode defaults for various pediatric
age ranges using the provided tables. Modify aspects related to fitting formula,
global parameters, hearing instrument options, program settings, and program
options.

*  Standard Mode: View and / or edit the fitting mode defaults for standard mode
(@dults) using the provided tables. Modify aspects related to fitting formula, global
parameters, hearing instrument options, program settings, and program options.

Reports
*  Forms: enter clinic information.

*  Graphs: select the preferred graph type: Output or Gain for the Fitting Report. For
the Output graph type, choose from: HL, SPL Real Ear, SPL 2cc, SPL Ear Simulator.
For the Gain graph type, choose from: 2cc, Ear Simulator, Real Ear, Insertion Gain.

Fitting Device

*  NOAHIink: enable/disable the NOAHIink, perform a system check, configure
properties, or start the pairing wizard.

*  Noahlink Wireless: enable/disable the Noahlink Wireless, check connection.

*  HI-PRO: enable/disable the HI-PRO, perform a system check or configure.

* iCube II: enable/disable the iCube Il, perform a system check via USB or wireless
connection, upgrade firmware, or start the pairing wizard.

Sound System

* Sound Output: select either stereo speaker or Aurical.

*  Calibration: calibrate to ensure media player sound files are presented at the correct
level. Manual calibration uses a sound level meter. Play the calibration noise and
adjust the Unitron TrueFit volume slider and/or Windows volume slider until you
measure 80 dB (A) at the listening position (where the client will sit). For Automatic
calibration start the calibration wizard. This process uses the hearing instrument to
measure and adjust the sound level.

iCube Il Configuration

Opens the iCube Il configuration section in Preferences. The screen provides ability to
enable/disable the iCube II, perform a system check via USB or wireless connection,
upgrade firmware or start the pairing wizard (i.e., add an iCube If).

Accessory Firmware Update

Opens a wizard used to update accessories. The accessory must be connected to
the computer using an USB cable. After detecting the device, Unitron TrueFit will offer
available firmware updates.

Change uDirect 2 Language Pack
Opens up a wizard that will help you select a language for the speech notifications.



Unitron TrueFit software instruction guide v5.1

Help

Online Help & Support: links to the support section of Unitron website. Internet
connection is required. Support materials include items such as video tutorials,
guides, troubleshooting tips, specification sheets, FAQs, glossary, cable/programming
information and styles and colours.

Instruction Guide: direct link to this manual.

Training Session: is used to demonstrate the full functionality of each screen as

if hearing instruments were actually being programmed. It is useful for a better

demonstration of such features as the feedback optimization test and Lifestyle

(Log It All) data.

*  Selecting Training Session from the Help menu generates a dialog box where
several training scenarios can be selected. This includes a free-flow scenario and a
list of sample training scenarios with pre-defined data. Selecting a training scenario
may prompt you to save your current fitting session.

e Foranew client, the preferred hearing instrument technology level and style must
be chosen on the Selection screen to populate the fitting session. For sample
clients, the fitting session will be populated and ready to use. It is not necessary to
Detect the instruments to generate Data logging information, however, detection
is necessary to access other things such as the Feedback Optimization test. The
fitting session proceeds from there as if the chosen instruments were actually
connected to Unitron TrueFit.

e The Training Session cannot be saved.

Contact Us: links to the Unitron Contact Us web page.

Unitron Website: links to the Unitron website.

Support

*  Generate Support Package: produces a .zip file with relevant support information
that can be sent to the Unitron Software Support team, for troubleshooting
puUrposes.

*  Homologation Settings: sets the hearing instrument into a test mode used for
certification of product parameters.

*  Export Client for Support: exports client data from the software for support/
troubleshooting purposes.

e Register with NOAH4: register Unitron TrueFit with NOAH4 so that it will show up as
a module within NOAH4.

e Unregister from NOAH4: unregister Unitron TrueFit from NOAH4 so that it will no
longer show up as a module within NOAH4.

* TeamViewer: opens the TeamViewer Quick Support remote control application.

e Delete Ratings for this client: opens a window allowing you to confirm that you want
to remove access to Ratings for this client, which will delete their activation code
and delete all of their ratings.

About DSL v5: generates a dialog box displaying notices related to the DSL v5 formula.

About Unitron TrueFit: generates a dialog box displaying the software version and
copyright notices.



Unitron TrueFit software instruction guide v5.1

For more information about fitting Unitron hearing instruments
or about Unitron TrueFit fitting software, visit the Help feature
within Unitron TrueFit or visit unitron.com
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